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1 Prior to use (Important)  

1.1 Overview of rekordbox 

rekordbox is Pioneer DJ’s track organization and performance software, letting you manage 

music files, prepare sets and perform from the same rekordbox library on Pioneer DJ products 

using various DJ performance tools - Hot Cues, Sampler, Slicer, Sound Color FX, Beat FX, Beat 

Jump and Pad FX. 

 

 Create your own playlists with rekordbox - classify and search for music files stored on your 

computer according to the needs for various DJ scenes. 

 Analyze tracks - detect key, edit beats and tempo (BPM), and collect other important 

information of your music files prior to performance. 

 Set and store point information (for cueing, looping, hot cueing, etc.) prior to performance. 

 Enjoy live performance using FXs and samplers included in rekordbox dj. 

 

1. rekordbox allows you to use pre-set playlists with various point information for your live 

DJ performance. 

It is also able to record your DJ performance including improvised cue and loop information for 

the review of your DJ performance history. 

1.2 System requirements 

Prior to installing rekordbox, make sure to read 6.3 Software end user license agreement.  

 Supported OS 

rekordbox is supported under the following OS: 

Mac OS X (10.8, 10.9, 10.10) 

 Windows7 Home Premium / Professional / Ultimate 

 Windows 8 / 8.1, Windows 8 / 8.1 Pro 

The latest information (supported OS, required operating environment, etc.) is available on 

rekordbox Support Site (https://www.rekordbox.com/en/download/) 

 International language support for installation 

Installation program for rekordbox supports multiple languages: English, French, German, Italy, 

Dutch, Spanish, Portuguese, Russian, Chinese (simplified, traditional), Korean and Japanese. 
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When you use other language OS, follow the instructions on the screen and select English as 

language to install. 

 

 Required system (minimum required operating environment) 

Prior to installation, ensure whether your computer meets the following operating environment.  

CPU Intel Dual Core CPU  

Memory 4 GB or more RAM 

Hard disk/ SSD 250 MB free HD space (excluding space necessary for storing music 

files) 

Display 

resolution 

Display resolution ≥ 1280×768 

Sound Audio output to speakers, headphones, etc. (built-in or external audio 

device) 

Internet 

Connection 

For user registration or inquires, use a web browser supporting 128-bit 

SSL (i.e. Safari 2.0 and above, Internet Explorer® 8.0 and above). 

USB port A USB port for connection of the USB storage device is required to 

transfer music files to a USB device (flash memory, hard disk, etc.). 

LAN port An Ethernet LAN adapter (RJ45 port) for communicating with the DJ 

equipment is required to transfer music files to a PRO DJ LINK-

compatible CDJ/XDJ. For details, check the Operating Instructions of the 

Pioneer DJ product. 

 

Full functionality is not guaranteed with all computers even when the above operating 

environment conditions are fulfilled. 

Even with the required memory capacity indicated for the operating environment above, in the 

cases described below the software may not provide full functionality and performance due to 

lack of memory. In this case, take the necessary measures to ensure sufficient free memory. We 

recommend adding extra memory in order to achieve stable performance. 

- When there are many tracks being managed in the rekordbox library. 

- When resident programs and services are running 

Depending on your computer’s power saving settings and other factors, it may not be possible 

for your computer to achieve its optimum CPU and/or hard-disk processing capacity. Especially 

when using a laptop computer, make sure to utilize external AC power sources to ensure high 

performance settings of the computer while using rekordbox. 
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rekordbox may not operate properly when combined with other software programs installed on 

your computer. 

1.3 Communications environment on the computer (programs, OSs and 

networks) 

Depending on the security software used on your computer and its operating system’s settings, 

communications with DJ units or mobile devices may be interrupted. 

If this occurs, it will be necessary to check your settings for the following four programs to ensure 

that they are not blocked. Extension of program depends on OS of the computer you use; e.g. 

the extension “.app” is for Mac and “.exe” for Windows:  

 rekordbox.exe 

 PSvNFSd.exe 

 PSvLinkSysMgr.exe 

 edb_streamd.exe 

When sharing of the computer’s Internet connection is enabled, problems may arise in 

communications with other computers or DJ units connected on the LAN. Disable sharing of the 

computer’s Internet connection before connecting the computer to the LAN. 

The computer’s Internet connection sharing is deactivated as described below. 

 Mac OS X: Open [System Preferences], then at [Internet & Network], uncheck [Internet 

Sharing] under [Sharing]. 

 Windows: Open [Local Area Connection Properties], then at [Sharing], uncheck [Allow 

other network users to connect through this computer’s Internet connection] under 

[Internet Connection Sharing]. 

Communications with DJ units or mobile devices may also be interrupted if the network (IP 

address, port number, etc.) is restricted by a router or other communications device. 

For details on the communications devices, security software and the settings of the operating 

system you are using, contact the respective manufacturer or your sales agent. 
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 For Mac OS X  

Click the [Applications] > [rekordbox 4] Folder with Finder, then double-click [rekordbox]. 

 For Windows® 

Double-click the [rekordbox] icon (shortcut) on the desktop. 

 

1.8 Account registration 

You need to create a rekordbox account (KUVO account) before using rekordbox application. 

 If you have a rekordbox 3 account, you can use it. 

 Previously obtained rekordbox 2 license key or account obtained when submitted an 

inquiry cannot be used. 

1 Launch rekordbox, then account registration screen appears.  

 When you already registered rekordbox 3, this process is skipped. You can use 

rekordbox directly. 
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2 Click rekordbox [Register for a rekordbox account] to move to the account 

registration website. https://kuvo.com/rekordbox/signup/ 

3 Enter account name, email address and password. 

Read Terms of Service and Privacy Policy and tick the checkbox to agree. 

 You cannot use the application if you do not consent.  

4 Click [Create my account]. rekordbox will send necessary information to the 

registered email address. 

 Your account has not yet been created. 

5 Your account will be created when you complete the process according to the 

instructions in the email you receive.  

6 Launch rekordbox and enter the account name and password, then you can use 

rekordbox. 

7 When KUVO screen appears, you can choose your DJ playlist information either 

public or private.  

 When you change this setting later, open [KUVO] from the menu → select [Privacy 

Settings] to change. 

To use KUVO, please refer to the Configuration Guide. 

URL: http://kuvo.com/kuvoweb/docs/configulation guide/ConfigurationGuide.pdf 

 

  If you are not connected to the Internet 

Use a computer connected to the Internet access to log in to the KUVO website 

(http://kuvo.com/) using your rekordbox account details. Click [EDIT PROFILE] to download an 

account key (djprofile.nxs) from [EDIT PROFILE].  

Save the downloaded account key in the computer with rekordbox installed. 

 

Launch rekordbox account key activation window, click [You are not connected to the 

Internet?] and select account key file saved on the computer. Then activation of the account is 

complete and you can use rekordbox. 
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1.9 Selecting exporting library and layout setting 

After user registration, “Exporting Library and Layout setting” screen is displayed. Select DJ 

equipment you use from the drop-down menu. If the device name you wish to select is not 

displayed, choose CDJ/XDJ-AERO/XDJ-1000. For those who use Pioneer DJ controllers, 

please select "CDJ/XDJ-AERO/XDJ-1000". 

 

1.10 Install audio driver 

You may have to install an audio driver to output audio from rekordbox to Pioneer DJ equipment 

depending on your computer and your DJ equipment. Select the equipment you have and install 

appropriate audio driver. 

 

1.11 Entering administrator’s password (Mac) / Allowing user account 

control (Windows) 

If you are using a Mac, you will be asked to input a password. Enter the administrator’s 

password of your Mac. If you are using a Windows PC, you will be asked if you allow “rbinit.exe” 

to make changes on your computer. Confirm the publisher then click [Yes]. 

 

If you don’t do these procedures, additional features such as “rekordbox dj” cannot be activated. 

 

1.12 Using the online support site 

Before making inquiries on rekordbox operating procedures or technical issues, read the 

rekordbox manual and check the FAQ provided on the rekordbox online support site. 

<rekordbox online support site> 

http://rekordbox.com/ 

 User registration on the rekordbox online support site is required prior to making inquiries 

concerning rekordbox. 

 Be careful not to forget the log-in name (your e-mail address) and password specified when 

you registered. 

 Pioneer DJ Corporation collects your personal information for the following purposes: 

1. To provide customer support for your purchased product 
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2. To inform you of product or event information by e-mail 

3. To obtain feedback collected by survey for product planning purposes 

- Your personal information is kept confidential corresponding to the privacy policy set forth 

by our company. 

- Pioneer DJ’s privacy policy can be viewed on the rekordbox online support site. 

 When making inquiries regarding rekordbox, please be sure to let us know your computer 

type and specifications (CPU, installed memory and other connected peripherals, etc.), the 

operating system and version used, as well as concrete information regarding the issue at 

hand. 

- To inquire about configuration of your computer with non-Pioneer DJ peripheral devices 

and to obtain the corresponding technical support, contact the manufacturer or retailer. 

 Further version updates are anticipated for improved functionality and performance of 

rekordbox. Update programs will be available for download on the rekordbox online support 

site. We strongly recommend you check for the updates to always use the latest version of 

rekordbox. 
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2 Introduction 

2.1 Features of rekordbox 

2.1.1 Analysis of music files will take you to the new horizons of DJ 
performance 

 Music File Analysis 

Load tracks in your computer into rekordbox for analysis and create Collection. Waveform, 

beats and tempo (BPM) and other useful information are at your hand for higher levels of DJ 

performance. This will enhance your DJ performance further when you use Pioneer DJ products 

and applications. 

 Quantize 

When the quantize function is set to on, points are automatically set to the nearest beat position 

when setting cues and loops. 

 

 Beat Sync 

The beat positions and BPMs of tracks played on multiple DJ equipment can be automatically 

synchronized by analyzing music files by rekordbox. This will enable you to perform a wide 

variety of effect and mixing techniques. 

 

2.1.2 Enhanced browser facilitates quicker and easier music selection 

 Playlist 

Create playlist before DJ performance using rekordbox with your favorite music files and 

according to DJ scenes. You can select the right tune quicker at the live performance by 

importing prepared playlists including the ones created on iTunes. 

 

 Intelligent Playlist 

You can automatically create a list of music files by narrowing down the search using filters. 

 



17 

 

 MY TAG 

Pre-set personalized tag to each music file on your library as you wish including detailed genre 

and characteristics. Use My Tag filter to refine searches by tagged conditions. 

 

 Related Tracks 

Automatically suggests a list of related tracks that have similar BPM, key, color, comments and 

My Tag information. 

 

 Split Screen 

Opens browser screen as an independent window. Enables more comfortable DJ play 

maximizing the number of tracks displayed on the screen. 

 

2.1.3 Consolidate management of music files and data by linking Pioneer DJ 
products  

 Sync Manager 

You can export music files to devices always in an updated status by synchronizing rekordbox 

with iTunes and USB device. 

 DJ performance with storage media (SD & USB EXPORT) 

Export prepared tracks and playlists to USB devices (flash memory or hard drive) and SD 

memory card. You can export/import music files and data to/from DJ equipment. 

 DJ performance with multiple DJ equipment connected via LAN (PRO DJ LINK) 

Music files and data on USB device will be sent by LAN cable and played/shared on up to four 

Pioneer DJ products such as DJ players and mixers supporting the PRO DJ LINK function. 

If you connect a computer to the DJ equipment r with a LAN cable, the rekordbox music files 

and data can be loaded onto up to four DJ equipment in real time. 
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 Enjoy DJ performance using DJ application 

Connect DJ equipment and a computer with rekordbox installed via USB cable. You can 

perform DJ play using rekordbox through the operation of DJ equipment.   

 Obtain performance history 

Accumulating your DJ performance history at every scene and even in different DJ equipment, 

you can further develop your DJ style to a new level. 

 DJ set preparation using mobile device 

Music files that have been analyzed with rekordbox, playlists and information such as My 

Settings contents created with rekordbox, etc., can be transferred to rekordbox (iOS/Android). 

Also, music data that has been edited on rekordbox (iOS/Android) can be reflected in 

rekordbox.  

 

2.1.4 DJ performance using DJ application 

 Effect  

Various effects of BEAT FX, SOUND COLOR FX and RELEASE FX, quite popular in our DJ 

mixer DJM series and remix station RMX series, are installed in rekordbox, opening the door to 

a wide variety of DJ performance.  PAD FX is equipped for the operation of these effects using 

the pads.   

 Sampler  

rekordbox sampler deck has 16 sampler slots (20 including OSC samplers) that can be played 

simultaneously.     

You can perform One-Shot playback of sampler sound and loop playback in sync with a track on 

the deck. 

 

 Sequencer  

You can record, playback and store the sequences you played at the sampler deck.  
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 Slicer  

rekordbox slicer function divides a specified range into eight equal sections, and these 8 sliced 

sections are assigned to respective performance pads. While one of the performance pads is 

clicked and long-pressed, the sound divided and assigned to that pad is played in a loop.   

 

 

2.2 Contents 

The contents of this manual are as follows: 

1. Prior to use 

2. Introduction 

3. Common features of EXPORT/ PERFORMANCE mode  

4. EXPORT mode 

5. PERFORMANCE mode 

6. Legal information 

 

Chapter 1 provides operation suggestions and precautions prior to use. Overview of this 

application is described in Chapter 2. Chapter 3 provides common features of EXPORT/ 

PERFORMANCE mode. Specific features of EXPORT mode and PERFORMANCE mode are 

described in Chapter 4 and 5, respectively, followed by Chapter 6 providing legal information 

including disclaimer and software end-user license agreement.  

2.3 How to use this manual 

We recommend you to use this manual flexibly, according to your needs. 

 

 Use rekordbox with for live DJ performance with controller, CDJ/XDJ 

Read Chapter 3. (Common features of EXPORT/ PERFORMANCE mode) and 5. 

(PERFORMANCE mode) 
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 Export music files to prepare for DJ performance with CDJ/XDJ, or DJ 

performance using PRO DJ LINK feature with devices connected via LAN. 

Read Chapter 3. (Common features of EXPORT/ PERFORMANCE mode) and 4. (EXPORT 

mode).  

 Like to know specific topic in rekordbox 

See Contents and go to the page of the topic. 

2.4 EXPORT and PERFORMANCE mode 

rekordbox provides two types of application for your DJ set preparation and liver DJ 

performance. 

 EXPORT mode 

You can export tracks and playlists to USB device/SD card, and enjoy DJ performance via PRO 

DJ LINK (CDJ/XDJ devices connected via LAN) 

 PERMORMANCE mode 

Using controllers and CDJ/XDJ supporting rekordbox, you can enjoy DJ performance with 

rekordbox dj. 

2.4.2 EXPORT mode 

EXPORT mode is the mode that offers conventional functionality of previous rekordbox.  

You can create playlists, analyze music files and save MEMORY CUEs/HOT CUEs, etc. 
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Library of music files and playlists managed in rekordbox can be exported to USB device/SD 

card.  Inserting USB device/SD card to players supporting rekordbox, you can use exported 

track/playlists on the device.  

You can also transfer music files directly to CDJ/XDJ supporting PC/Mac via PRO DJ LINK. For 

details of PRO DJ LINK, see 4.12 (DJ performance on DJ equipment connected to LAN). 

Note: Export to USB device/SD card and transfer of music files via PRO DJ LINK can be 

available only in EXPORT mode. 

 

In EXPORT mode, you can enjoy simple DJ mix with 2 Player mode. 

For pro-DJ performance including monitoring through headphone CUE, using EQ, FXs, etc., 

use PERFORMANCE mode. 

 

2.4.3 PERFORMANCE mode 

Use PERFORMANCE mode for DJ mix performance.  

You can enjoy professional DJ performance with maximum 4 decks, 16 samplers and various 

features including FXs.  
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PERFORMANCE mode will become available by activating rekordbox dj Plus Pack with a 

license key.  

You can try PERFORMANCE mode for 30 days for free without a license key. 

 

2.5 Using PERFORMANCE mode 

To use PERFORMANCE mode (mode to use DJ performance function) of rekordbox, activation 

(license authentication) of rekordbox dj Plus Pack is required. Here are instructions for 

activation procedures. 

 

 License key 

To activate PERFORMANCE mode of rekordbox, a license key for rekordbox dj Plus Pack is 

necessary. You can get a license key as follows: 

 Purchase Pioneer DJ’s DJ controller bundled with rekordbox dj Plus Pack license key. 

 Purchase rekordbox dj Plus Pack license key at the Pioneer DJ website: 

(http://www.pioneerdj.com/). 

 

When you purchased Pioneer DJ’s DJ controller with the license key, it is attached on the back 

of the unit. For more information, see the Operating Instructions of the controller. 
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When you purchased a license key at the Pioneer DJ website, the license key will be sent via e-

mail.  

You can activate rekordbox dj Plus Pack on up to two computers with one license key. 

2.5.2 Activation 

Before you activate rekordbox dj, ensure that your computer is properly connected to the 

internet.  

After installation of this application, the activation window automatically appears ay the first time 

you launch the rekordbox. In this case, you can skip the process 1 and start from the process 2. 

If it is not the first time for launch and the activation screen does not appear automatically, 

please start from the process 1.  

 

1. Select [Activate] < [Help] from the application menu. 

[Activate] screen opens like below. 

 

 When the application is launched for the first time, this window will be displayed 

automatically. 

 

2. Click [Activate].  
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A screen to enter e-mail and password appears.

 

3. Enter your e-mail address and password which you used for rekordbox account 

registration, then click [OK]. 

A screen to input a license key is displayed. 

 If you forgot your password, click “Forgot your password?” The web page for resetting 

your password is displayed. Enter your e-mail address on that page to reset your 

password. 

 

4. Input license key and then click [OK]. 

License key contains 29 characters including letters, numbers and dashes. Input all the 

alphabet with capital letters including dashes.  

 If you are asked the password of the administrator’s password, input the password. 

 If you are asked to run “rbinit.exe”, click [Yes]. 
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When “The license has been activated successfully” appears, activation has been 

completed. 

 If “License key is wrong” appears, re-enter the correct license key. 

 If “Not connected to the Internet” appears, check the internet connection. 

  

 

2.5.3 Downloading and installing Sampler Plus Pack 

Once you activate rekordbox, you can download sampling materials “Sampler Plus Pack” which 

can be used in the sampler of rekordbox free of charge. Select [Download Sampler Plus Pack] 

from [File] menu. After downloading, select [Import Sampler Plus Pack] from [File] menu, then 

locate the downloaded file. Files are imported and you can use them in the sampler. 

 

2.5.4 Cautions for activation 

Activation is associated with your computer system. If you change settings of your system such 

as creating partition on your start up disk, activation might become invalid. Deactivate license 

before you make changes to your system. 

 

2.5.5 Using license key for other computers 

One license key can be used for maximum activate up to two computers. When you replace 

your computer, for example, you have to deactivate the license you already installed to relocate 

reuse the license key.   

Before you deactivate a license, ensure that your computer is properly connected to the Internet 

and then follow these instructions to deactivate license.  

 Deactivation 

1 Launch rekordbox on the computer you already activated. 
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2 Click [Preferences] to open [Preferences]. 

3  Click the [License] tab. 

 

4 Write down the license key shown in the License Key section. 

 This is the same license key you entered to activate the application.  

5 Click [Deactivate]. 

You will be asked to input your e-mail and password of your rekordbox account. 

 

6 Enter your e-mail address and password, then click [OK]. 

A message saying “Deactivation has been successfully completed” is displayed when the 

process normally completed. If not, ensure that your computer is properly connected to 

the Internet. 
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7 Launch rekordbox on the computer you wish to activate.  

8 Activate rekordbox dj using the license key you wrote down in the process 4 

described above. 

 For instructions for activation, see 2.5.2 Activation of this manual.  

 

2.6 Trial of PERFORMANCE mode (Trial mode) 

Although PERFORMANCE mode of rekordbox becomes available by activating “rekordbox dj 

Plus Pack” with a license key, you can try PERFORMANCE mode for 30 days even if you do not 

have a license key. 

 

2.6.1 Starting trial 

Select [Help] > [Activate] from the application menu.  

Click “Try rekordbox dj for 30 days” on the screen. You will be asked if you would like to start 

trial. Click “Yes”. 

If you are asked the password of the administrator’s password, input the       

password. 

If you are asked to run “rbinit.exe”, click [Yes]. 

 

Trial mode is available for 30 days. 

PERFORMANCE mode will become unavailable after 30 days. 

Once trial period has been expired, you cannot use trial mode even if you reinstall rekordbox. 
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3 Common features of EXPORT/ PERFORMANCE mode  

This chapter illustrates common features of EXPORT/PERFORMANCE mode. For specific 

function of each mode, see 4 EXPORT mode or 5 PERFORMANCE mode.  

3.1 Adding music files to Collection 

[Collection] is a list of all the tracks organized by rekordbox. 

Music files in your computer will be analyzed and stored to create Collection of rekordbox.   

 

 

3.1.1 Adding music files to Collection 

1 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Open Finder or Windows Explorer and drag and drop music files and/or folders, 

where music files are stored, to the track list. 

The music file is added to Collection, and its tag information is loaded and displayed. Analysis 

will start if Auto Analysis is activated. When analysis of the music file’s waveform information 

begins, the progress status  is displayed to the left of the music file being analyzed, 

then turns off once analysis is completed. 

 There is a choice of two modes for analyzing the waveform information of music files: 

[Normal] and [Dynamic]. 

 You can also import music files and folders by selecting [File] menu > [Import]. 

 When a WAV file is added to Collection, its tag information may not be displayed. The 

tag information of music files that can be read is ID 3 tag (v1, v1.1, v2.2.0, v2.3.0, and 

v2.4.0) of MP3 and AIFF files, the meta tag of M4A files, and RIFF INFO of WAVE files 

and Vorbis Comment of FLAC files. 

 You can set [On] or [Off] of Auto Analysis in [Auto Analysis] in [Track] menu. 
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 Once analysis of the music file’s waveform information is completed, the beat 

positions and tempo (BPM) can be checked on the player panel. Also, the waveform is 

displayed in the [Preview] column of the Browser panel. 

 To detect key of the music, select a music file and tick [Analyze Key] in the right-click 

menu.  

 You can automatically set Memory Cues at the first beat of tracks and save them. Tick 

[Set Memory Cue at the first beat of track when analyzing] at [Analysis] tab of 

[Preferences] window. Cues will be set automatically when importing and re-analyzing.    

 To remove music files from Collection, select the music file at [Collection] then press 

the [Delete] key on the computer’s keyboard. The music file is removed from 

Collection, but the music file itself is not deleted from the computer. 

  

3.1.2 Editing information on a music file 

1 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click . 

The [Information] window is displayed on the right of the track list. 

3 Click a music file in [Collection] you wish to edit information. 

The [Summary] is displayed in the [Information] window. 

4 Click the [Info] tab in the [Information] window. 

The [Info] is displayed in the [Information] window. 

5 Edit the information. 

The information of the music file is changed. 

6  

3.1.3 Adding an artwork image to a music file  

The artwork image formats which can be added to a music file are JPEG and PNG (extensions: 

“jpg”, “jpeg”, “png”). 

1 Click the [Artwork] tab in the [Information] window. 

2 Open Finder/Windows Explorer. 

3 Drag an image file from Finder/Windows Explorer to the [Artwork]. 
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The artwork image is added to the music file. 

3.1.4 Reloading tag information of a music file 

When an external application software is used to update tag information of the music file, you 

need to update the tag information by reloading it in rekordbox. 

Click  on the upper right of [Information] window. 

The tag information of a music file is reloaded. 

You can reload the tag information by selecting the track you wish to reload tag info and 

click [Reload Tag] in context menu (right-click menu).  

 

When tag information of a music file is reloaded, the contents previously edited at the 

[Info] and [Artwork] tabs are replaced with the reloaded tag information. 
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3.2 Searching for music files  

Operate the browser panel to browse and search the music file information 

 

 

 You can create tags as you wish to refine your search for music files. For further 

information, see 3.5.4 (Customized browsing using My Tag). 

 

3.2.1 Searching for music files with category filter 

1 Click [Collection] in the tree view. 

Music files in [Collection] are displayed in the track list. 

2 Click  on the left of the search filter . 

A list of searchable columns is displayed. 

3 Select and click the column you wish to search from the drop-down menu. 

4 Enter characters in the search filter with the computer keyboard. 

Only the music files including the character string you have input are displayed on the 

track list, with the columns selected in step 3 as the searching range. 

 This display will be reset when characters are deleted or the  button is clicked. 

 

3.2.2 Searching for a music file using the category filter  

1 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click   on the top of the track list. 

A list of the Category columns ([Genre], [Artist], [Album]) is displayed. 



32 

 

3 Select and click the item of the column you wish to search from the drop-down 

menu. 

 

3.2.3 Sorting information to search for music files 

 

1 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click the column header by which you wish to reorder. 

The arrangement of music files is changed. 

 Each time you click, the arrangement toggles between ascending and descending orders. 

3 Input character using the computer’s keyboard. (Alphabet search) 

The tracks starting with the character are listed and the first is highlighted. 

 Input another character to list up the tracks that start with the character you input. 

 Alphabet search will not be activated in PERFORMANCE/TRAIAL mode. Use 

keyboard shortcut function. 

3.2.4 Change columns shown in the track list and their order 

1 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Right-click the column header. 

A list of the column names that can be displayed is shown. 

3 From the drop-down menu, tick the column names you wish to display. 

The columns are changed. 

4 Drag the column header left or right. 

The order of the columns is changed. 
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3.3 Organizing music files by using playlists 

You can organize the music collection on rekordbox by creating playlists prior to DJ 

performance. 

 

 

3.3.1 Creating a new playlist 

1 Click  on the right side of playlists or a playlist folder. 

New playlist ([Untitled Playlist]) is created under [Playlists]. 

2 Input the playlist’s name from the computer’s keyboard, then press the [Enter] 

key. 

The name of the Playlist is changed. 

3 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

4 Drag a music file to the playlist you have created in Tree View. 

The music file is added to the playlist. 
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 Music files can also be added to the playlist by dragging them from [iTunes], [Tag List] or 

other playlists. 

 To delete a playlist, select the playlist then press the [Delete] key on the computer’s 

keyboard. 

 To remove a music file from a playlist, select the music file then press the [Delete] key on the 

computer’s keyboard. 

 

3.3.2 Adding playlists by importing an external file 

The playlist file formats which can be imported are M3U and M3U8 (extensions: “m3u”, “m3u8”). 

1 Select [File] menu > [Import] > [Import Playlist]. 

The [Import Playlist] window opens. 

2 Select the folder of the playlist file or the file name, then click [Open]. 

The playlist is added to [Playlists]. 

3 The tag information for the music files in the playlist is loaded and displayed, 

and when [Auto Analysis] in the [Track] menu is [On], analysis of the music files 

begins.  

 

3.3.3 Organizing playlists by using folders 

1 Right-click the [Playlists] and select [Create New Folder]. 

[Untitled Folder] is created under the [Playlists]. 

2 Input the folder’s name from the computer’s keyboard, then press the [Enter] 

key. 

3 Drag playlist to the newly created Folder. 

Playlist is moved under the newly created folder. 

 To delete a folder, select the folder then press the [Delete] key on the computer’s 

keyboard. The folder and all the playlists contained in the folder are deleted.  

 

3.3.4 Adding an artwork image to playlist  

The artwork image file formats which can be added are JPEG or PNG (extensions: “jpg”, “jpeg”, 

“png”). 
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1 Right-click a playlist and select [Add Artwork]. 

The [Select an artwork] window opens. 

2 Select the folder of the image file and the file name, then click [Open]. 

The artwork image is added to the playlist. 

 The added artwork images are displayed when the playlist is right-clicked. 

 

3.4 Browsing external library 

iTunes library and music files stored in your computer can be used on rekordbox. You can also 

use rekordbox xml library.  

3.4.1 Browsing iTunes Library 

If iTunes is installed to your computer, iTunes library can be used on rekordbox. 

 

 If iTunes library is not shown, make the following settings. 

- Open [Preferences] > [View] and tick [iTunes] in [Tree View] section in [Layout] row. 

- Open [Preferences] > [Advanced] > [Database] tab and specify a library file at [iTunes] 

section.  

 Click  on the right side of [iTunes] in Tree View of the screen to update the [iTunes] library 

in rekordbox. 

 If iTunes library has been updated when rekordbox is running, the update will not be 

reflected until  is clicked. 

 Adding iTunes music files to rekordbox 

You can add iTunes music files to the rekordbox Collection. 

1 Click  to the left of [iTunes] in Tree View; then, click [All Tracks]. 

A list of iTunes music files are shown in the track list. 

2 Drag the iTunes music files in the track list to [Collection]. 

The music files are added to [Collection]. 
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 is shown for the music files imported to folders in [iTunes]. Waveforms, artworks, BPM and 

keys analyzed by rekordbox are also shown. 

 

 Adding a playlist from iTunes Library to rekordbox Playlists 

You can import playlists in iTunes library to rekordbox Playlists.  

1 Click  on the left side of [iTunes] in Tree View and click  on the left side of 

[Playlists]. 

A list of iTunes playlist is shown in Tree View. 

2 Drag iTunes playlist to [Playlists]. 

iTunes playlist is added to [Playlists] as a rekordbox Playlist. 

 Reloading the iTunes library information  

You can reload your updated iTunes library information to reflect it in rekordbox. 

1 Click [Collection] in Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Right-click the music file and select [Get Info from iTunes]. 

The iTunes library information is reloaded. 

When the iTunes library information is reloaded, information that has been edited under the 

[Information] window’s [Info] tab is replaced with the reloaded information. 

 

3.4.2 Use folders and music files in your computer and USB flash drive  

1 Click  on the left side of [Explorer] in Tree View. 

Folders in your computer and external devices such as a USB flash drive are shown in Tree 

View. 

 If [Explorer] is not shown in Tree View, open [Preferences] > [View] and tick [Explorer] in 

[Tree View] section in [Layout] row. 

2 Select a folder in [Explorer]. 

Music files in the selected folder are shown in the track list. 
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 Adding music files in the computer to rekordbox 

1 Select a folder in [Explorer]. 

Music files in the folder are shown in track list. 

 If [Explorer] is not shown in Tree View, open [Preferences] > [View] and tick [Explorer] in 

[Tree View] section in [Layout] row. 

2 Drag the music files in the track list to [Collection]. 

The music files are added to [Collection]. 

  is shown for the music files imported to folders in [Explorer]. Waveforms, artworks, 

BPM and keys analyzed by rekordbox are also shown.  

 

 Adding a folder stored in the computer and an external device, such as a USB 

flash drive, as a playlist 

Drag a folder in [Explorer] to [Playlists] in Tree View. 

A playlist is created with the name of the folder.  

 

3.4.3  rekordbox xml 

Import files written in rekordbox xml format to use rekordbox xml library. 

 

1 Select rekordbox xml. 

Open [Preferences] > [Advanced] > [Database] tab, and click  at [Imported 

Library] in [rekordbox xml] section, and specify an xml file. 

2 Display rekordbox xml in Tree View. 

Open [Preferences] > [View] and tick [rekordbox xml] in [Tree View] section at [Layout] row. 

rekordbox xml is shown in Tree View. 

 Add music files from rekordbox xml 

1 Click  on the left side of [rekordbox xml] in Tree View and click [All Tracks]. 

A list of rekordbox xml music files are shown in the track list. 



38 

 

2 Drag the rekordbox xml music files in the track list to [Collection]. 

The music files are added to [Collection]. 

 Add a playlist from rekordbox xml  

You can import playlists in rekordbox xml library to rekordbox and add them to Playlist. 

1 Click  on the left side of [rekordbox xml] in Tree View and click  on the left 

side of [Playlists]. A list of rekordbox xml playlist is shown in Tree View. 

A list of rekordbox xml playlist is shown in Tree View. 

2 Drag rekordbox xml playlist under [Playlists]. 

rekordbox xml playlist is added to [Playlists]. 

 

3.5 Effortless and intuitive DJ set preparation using various features of 

rekordbox  

This section provides you how to efficiently use many features to support preparation for DJ 

performance.  

3.5.1 Shortcuts instantly navigate you in Tree View 

If you create a shortcut of a folder or a playlist in Tree View and click it, the folder or the playlist is 

shown and highlighted instantly. 

 Up to eight shortcuts can be created there. 

 The shortcut is hidden by default. 
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1 Click  in Tree View. 

 

The shortcut column is shown. 

2 Drag a folder or a playlist in Tree View to an empty field of the shortcut column. 
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A shortcut for a folder or a playlist is created there. 

 If you drag a folder or a playlist to an already created shortcut, the shortcut is overwritten 

with the newly dragged one. 

3 Click a shortcut you have created. 

The folder or playlist in Tree View is instantly displayed and highlighted. 

 If a shortcut is dragged upward or downward and dropped, the order of the shortcuts can 

be arranged. 

 Right-click the shortcut and select [Delete Shortcut] to remove the shortcut. (Even if the 

shortcut is removed, the original folder or playlist will not be deleted.) 

 If you drag a track to the playlist shortcut, the track can be added to the playlist. 

  

3.5.2 Playlist Palette to display multiple playlists for easier track selection 

You can easily narrow down and select tracks using Playlist Palette. 

 Assign Playlists to a Palette. Maximum 4 Playlists can be displayed simultaneously in the 

Palette and the Playlists can be edited there. 

 The Playlists in the Palettes will remain as they are even after you exit rekordbox. 
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 Selecting a Palette 

 

Three palettes on the right among the four palettes are the Playlist Palettes. 

The far left Palette  is used as Tag List. 

Click . 

Four Playlists are displayed in a Palette. 

Click  to open and close track lists in the Palette. 

 Assigning a Playlist to a Palette 

Drag and drop a playlist in Tree View to a Palette. 

The playlist is assigned to the Palette. 

 The previously assigned playlist is overwritten with the new one. 

 

 Adding tracks to the Palette 

Drag a track in the track list to a Playlist of the Palette. 

The track is added to a playlist in the Palette. 

When a track is dragged to [blank list], [Untitled Playlist] is created. 

Type the playlist name on your computer keyboard. 

Now, a new playlist is added to [Playlists]. 

 Double click the playlist name on the Palette to edit the playlist name. 
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 Adding a track in the Palette to another Playlist 

Drag a track in a playlist of the Palette to another playlist. 

 In the Palette, a track in a playlist can be added to another playlist by dragging it. 

 

 Loading a track in the Palette to player/deck panel. 

Drag a track in the Palette and drop it to a player panel. 

The track in the Palette is loaded to the player/deck. 

 Sorting tracks in the Palette 

1 Click  on the right side of the playlist name bar of the Palette. 

A drop-down menu appears. You can also right-click the playlist name bar to display the drop-

down menu. 

2 Put the mouse pointer to [Sort] and select [Track Order] or [Title] as you wish. 

 

Tracks are sorted in the order of the criteria you selected (Track Order is the order you set at 

the playlist column name). 

  is shown on the right side of the Playlist name during sorting. 
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3 Click . 

You can toggle between ascending and descending order. 

  means the list is in ascending order and  in descending order. 

 Changing the order of tracks in the Palette 

Drag a track upward or downward to move the track within a playlist of the 

Palette. 

The order of tracks in the Palette can be changed. 

 This method is enabled only when the tracks are sorted by [Track Order] in the [Sort] in 

right-click menu. If it is sorted by [Title], it is disabled. 

 Removing the Playlist from the Palette 

1 Click  on the right side of the Playlist name. 

A dropdown menu appears. 

2 Click [Remove from Palette]. 

The playlist in the Palette is removed, and the Palette becomes empty. 

 

 Changing the order of the playlist in Palette 

Drag and drop the playlist name of the Palette to another column in the palette. 

The order of the 4 playlists in the Palette can be arranged. 

 

 Highlighting the playlist in Tree View 

Click a playlist name of the Palette. 

The same playlist name in Tree View is highlighted. 
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3.5.3 Organizing music files using Intelligent Playlists 

You can automatically create a playlist of music files by narrowing down the search using filters. 

 Creating an Intelligent Playlist 

1 Right-click in [Playlists] and select [Create New Intelligent Playlist] in the 

dropdown menu. 

 

The Setup window for Intelligent Playlist opens. 

2 Select the filters to narrow down the search. 

 

 Select a filter. 

 Select how to narrow down your search. 

 [=]: Music files which fully match the text or value you entered are shown in the list. 

 [≠]: Music files which do not match the text or value you entered are shown in the list. 

 [>]: Music files whose value is larger than the one you entered are shown in the list. 

 [<]: Music files whose value is smaller than the one you entered are shown in the list. 

 [contains]: Music files which contain the text you entered are shown in the list. 

 [does not contain]: Music files which do not contain the text you entered are shown in the 

list. 

 [starts with]: Music files which start with the text you entered are shown in the list. 
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 [ends with]: Music files which end with the text you entered are shown in the list. 

 [is in the range] : Music files whose value is in the range of the 2 values you entered are 

shown in the list. 

 [is in the last] : Music files whose date is within the days or months ago from the current 

date you entered are shown in the list. 

 [is not in the last] : Music files whose date is not within the days or months ago from the 

current date you entered are shown in the list. 

 Specify condition for the filter you selected. 

Enter a text or a value using your computer keyboard if the drop-down menu is not shown. 

 Click the [+] button to add another filter. 

A new filter is added to the one you set. 

Click to select [Match all of the following conditions] or [Match any of the following conditions] 

filters. 

 Delete a filter. 

Click the [-] button to delete a filter which you do not need. 

 Type in the name of the Intelligent Playlist. 

Type the text using your computer keyboard. 

 Click [OK] or [Cancel] to confirm or cancel the filters. 

3 Click the [OK] button. 

An Intelligent Playlist is created below [Playlists] in Tree View folder. 

 

 Right-click the Intelligent Playlist in Tree View and select [Edit the Intelligent Playlist] to 

show and edit the filters to narrow down the search. 

 Right-click an Intelligent Playlist Tree View and select [Delete Playlist] to delete it. You can 

also delete an Intelligent Playlist by pressing the [Delete] key on your computer after 

selecting the Intelligent Playlist. 
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3.5.4 Customized browsing using My Tag 

You can refine your search by creating tags for music files. 

Browsing can be customized by creating tags as you wish defining the tracks’ features for better 

use for DJ occasions. 

 User-defined My Tag can be attached to a music file selected in the track list. 

 My Tag attached to music files are shown in the My Tag column. 

 You can narrow down your search using My Tag filter by setting My Tag as search criteria. 

 

 Editing My Tag 

1 Click  on the right edge of the screen. 

My Tag drop-down menu is shown on the right side of the track list. 

 

 Category: You can add category names you wish. 

 My Tag has 4 categories and the category names can be changed as you wish. 

 My Tag: You can attach tags to music files. You can change tag names as you wish. 

 My Tag checkbox: Tick this checkbox to attach or remove a tag to the music file selected in 

the track list. 

 Create a new tag button: Click this button to create a new tag to My Tag. 
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2 Changing the category name 

Click a category name and type letters using computer keyboard. Then, press the [Enter] key. 

The name of the category is changed. 

3 Changing the tag name 

Click a tag for My Tag and type letters using computer keyboard. Then, press the [Enter] key. 

The name of the tag is changed. 

 Attaching My Tag to a music file 

1 Click a music file where you wish to attach My Tag among the music files in the 

track list. 

The selected music file is highlighted. 

2 Tick the checkbox in front of the tag you wish to attach. 

The ticked tag is attached to the music file. Tick other tags’ checkboxes if you wish to attach 

them. 

 Open [Preferences] > [Advanced] > [Browse] tab and tick a checkbox of [Add “My Tag” to 

the “Comments”] to show My Tag in the Comments column of the track list. 
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 Refining search using My Tag 

 

1 Click  on the left side of the search filter. 

My Tag filter is displayed. 

2 Select BPM. 

Music files whose BPM is within the selected BPM range are displayed in the track list. 

3 Click My Tag you wish to search. 

Only the music files to which the selected My Tag is attached are displayed in the track list. 

 Multiple tags can be selected. 

When multiple tags are selected, the music files containing all the selected tags are 

displayed in the track list. 

 Click [RST] (Reset selection) to cancel all the tags selected in My Tag filter. 

 Deleting My Tag 

1 Click  on the right edge of the screen. 

My Tag drop-down menu is shown on the right side of the track list. 

2 Right-click a tag in [My tag] and click [Delete]. 

The tag is deleted. 
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3.5.5 Display related tracks 

Tracks related to the current track are automatically listed and shown in the [Related Tracks] 

window. You can specify how they are related as you wish, based on the criteria of track 

information such as BPM, Key, Color, Rating and My Tag, etc. 

You can instantly define good match combination of tracks in the 2 Players/Deck mode in 

EXPORT/PERFORMANCE mode and the combination is saved and displayed. 

In PERFORMANCE mode, select 2Deck mode and hover the mouse pointer to the right 

(horizontal)/bottom (vertical) edge of waveforms to show the Matching button  . 

1 Click . 

The [Related Tracks] window is displayed. 

 

2 Click . 

The window to customize the criteria appears. 

3 Select criteria to specify how tracks are related. 
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Current track: Specify a track you wish to know its related tracks 

 EXPORT mode 

 PLAYER A: Track loaded to [PLAYER A] is specified. 

 PLAYER B: Track loaded to [PLAYER B] is specified. 

 MASTER PLAYER: Track loaded to [MASTER PLAYER] is specified. 

 LIST: Track you select in the track list window (highlighted) is specified. 

 

PERFORMANCE mode:  

 Deck1: Track loaded to [Deck1] is specified. 

 Deck2: Track loaded to [Deck2] is specified. 

 Deck3: Track loaded to [Deck3] is specified. 

 Deck4: Track loaded to [Deck4] is specified. 

 MASTER DECK: Track loaded to [MASTER DECK] is specified. 

 LIST: Track you select in the track list window (highlighted) is specified. 

 

Search Target: Select search target  

 Tracks in the Collection: Search all tracks in Collection. 

 Tracks in the selected playlist: Search all tracks in the playlist currently shown in the 
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track list. 

 

    Criteria: Select criteria of search 

 BPM/Key, etc.: Tracks similar to the current track in terms of BPM, key, etc. is shown. 

 History: Suggested tracks are shown based on your playback history on CDJ stored in 

rekordbox. 

 Matching: Tracks you previously selected by clicking  icon as a good match 

combination in 2 Players mode are shown. 

  

When [BPM/Key, etc.] are selected, the following parameters can be selected. 

 Range of BPM: Set within 0 % – 30 % range from the current track. 

 Key: Select among [Same key], [Related key 1] and [Related key 2]. 

 Date Added: Enter how many days ago to set the time frame (within 180 days). 

 Tracks in the same genre: Select the tracks in the same genre. 

 Tracks with the same color: Select the tracks with the same color. 

 Rating: Select tracks with the ratings you specified. 

 My Tag: Select [Match all of the items] or [Match any of the items]. 

4 Select the criteria and click [OK]. 

The criteria is now set in details. 

3.5.6 Sub Browser 

While using the browser, you can open the sub browser that shows tree view to display 

Collection and Playlist. This is called Sub Browser Window. 

Tree view items excluding Explorer can be viewed in Sub Browser Window. 

 Two browsers allow you to easily drag and drop tracks and playlists from one to the other. 

Click the [Sub Browser Window] button  on the far right to open and close the sub browser. 
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4 EXPORT mode 

4.1 Using rekordbox to prepare for DJ performance 

 

1 Import music files into your computer. 

Store music files on your computer. 

 rekordbox does not allow you to import music files from audio CDs or purchase music 

files over the internet. It is recommended to have music files ready on your computer 

which have been imported by other applications. 

2 Add music files to Collection on rekordbox. 

Analyze and measure the beat and tempo (BPM) of music files. 

 You can import tag information of music files (e.g. MP3, AAC, WAV, AIFF) as well as 

information on music files from iTunes library. 

3 Make preparations for DJ performance using rekordbox. 

Set and store various point information (for cueing, looping and hot cueing). 

Create lists to be used for DJ performance (playlists and hot cue bank lists). 

 You can import playlists (M3U, M3U8) created by other software as well as those in 

[iTunes] and [rekordbox xml]. 

4 DJ performance with DJ equipment. 

Enjoy DJ performance on Pioneer DJ’s DJ equipment using the point information and playlists 

prepared with rekordbox. 
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 Performance history on Pioneer DJ’s DJ equipment such as number of times played and 

cue and loop point information is saved and can be reflected to rekordbox. 

 

 Using mobile devices to prepare for DJ performance 

 

Music files that have been analyzed with rekordbox, Playlists, My Settings and other information 

created with rekordbox can be transferred to mobile devices (e.g. iPhones, Android™ devices). 

Also, music data that has been edited on mobile devices can be reflected to rekordbox. 

 rekordbox must also be installed on the mobile device. The mobile device version of 

rekordbox can be downloaded onto the mobile device from online software markets, such as 

App Store and Google Play. 

 For the functions that can be used with mobile devices, see the user’s manual of the mobile 

device version of rekordbox. 

 For instructions on making wireless LAN connections, see the Operating Instructions of your 

mobile device, computer or wireless LAN device. 
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4.2 Using rekordbox with DJ equipment 

Be sure to read the information on “Safety Precautions” and “Connections” in the Operating 

Instructions for each Pioneer DJ’s DJ equipment before connecting the equipment to your 

computer. 

To check the compatibility of SD memory cards and USB devices (flash memory or hard disk) 

with your Pioneer DJ’s DJ equipment, see the Operating Instructions of each equipment. 

The latest information on Pioneer DJ’s DJ equipment supporting rekordbox is available on 

the rekordbox online support site. 

 DJ performance with a USB device (USB EXPORT) 

         

XDJ-RX XDJ-1000 

 

You can load music files and data prepared with rekordbox to DJ equipment via USB devices 

(flash memory or hard disk). 

 In addition to USB devices, SD memory cards can be used for some DJ equipment 

(e.g.CDJ-2000nexus and CDJ-2000). 
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 DJ performance with connection to a LAN (LINK EXPORT) 

     XDJ-RX XDJ-1000 

 

You can load music files or data from rekordbox onto DJ equipment in real time if you connect the 

computer to the DJ equipment with a LAN cable or wireless LAN. 

 For instructions on connections, see the Operating Instructions for each DJ equipment and 

computer. 

 

 DJ performance with multiple DJ units (PRO DJ LINK) 

       XDJ-1000 

 

When a PRO DJ LINK-compatible DJ mixer and DJ equipment are connected via 

LAN, rekordbox music files and data stored on a USB device can be transferred to up to four DJ 

equipment. 

 SD memory cards can also be used for some DJ equipment (e.g.CDJ-2000nexus or CDJ-

2000). 

 A switching hub can be used in place of a DJ mixer. 

 For instructions on connections, see the Operating Instructions for each specific DJ 

equipment. 
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When you connect a computer with rekordbox to PRO DJ LINK wired LAN, rekordbox music files 

and data can be loaded in real time on up to four DJ equipment. 

Also, when a DJ mixer supporting PRO DJ LINK and a computer with rekordbox are connected 

via LAN, rekordbox music files can be monitored over headphones connected to the DJ mixer. 

 A switching hub can be used in place of a DJ mixer to connect via LAN. 

 Up to two computers can be connected via PRO DJ LINK. 

 For instructions on connections, see the Operating Instructions for each respective DJ unit 

and computer. 
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4.3 Names of parts 

4.3.1 Player panel 

 1 Player mode 

 

 

 

1  

 Click  to jump forward from the current playback position. 

 Click  to jump backward from the current playback position. 

2  

Moves to the beginning of a track (track search). 

 Click  to move to the beginning of the next track. 

 Click  to jump to the beginning of the currently playing track. Click  twice to 

jump back to the previous track. 

3 QUANTIZE 

 

Sets cue and loop points to the nearest beat grid point. 
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4 Artwork 

 

Displays the artwork images of music files. 

5  

Zooms in/out enlarged waveform display. 

6 Track information display 

 

Displays the title, artist and key of the music file loaded to the player. 

7 Mode Switch button 

 

Select Export/ PERFORMANCE mode.  

 

 

8 Enlarged waveform display 
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The playing position can be moved backwards or forwards by dragging the displayed 

waveform left and right. 

Beat positions detected by analyzing the music file are displayed as vertical lines. 

9 Playing address and full waveform display 

 

The current play position is indicated using a thin vertical line which is displayed over the 

waveform, and a horizontal bar displayed below the waveform to represent the progress 

of the track. 

 The horizontal bar lights up from the left side when in the time elapsed mode. 

 The horizontal bar turns off from the left side when in the time remaining mode. 

10 Total time 

 

Displays the total time of the track now playing. 

11 Time display in minute (M) and second (S) 

 

Click the time display to toggle between elapsed time and [–] (remaining time). 

12 BPM display 

 

Displays BPM (Beats Per Minute) of the track now playing. 

13 Player panel display selector 

 

Click the player panel display. 

 : One player is displayed in the Player panel. 

 : Two players are displayed in the Player panel. 

 : A simple player is displayed in the Player panel. 

 : Hides the Player panel. 
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14 Menu button 

 

Click this icon to open a menu to select the color of enlarged waveform, to analyze the 

currently playing track, and to export it to a device. 

 

 

 

15 Mute 

 

Click to mute the sound. Click again to cancel mute. 

16 Volume 

 

Drag up and down to adjust the volume. 

17 Preferences 

 

Opens the [Preferences] screen. 

18 Current time display 

 

Displays the current time on your computer clock. 

19 Audio dropout meter 
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Audio will dropout if it reaches to 100%. 

20 The sub-panel for the loaded track 

 

Displays information of the track now loaded to the player and comments for [MEMORY] 

and [HOT CUE]. 

21 Function panel 

 

Click the buttons to switch the function panel between [CUE/LOOP] and [GRID]. 

 

 

 

22 CUE 

 

Sets cue points. 
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23  

Starts or pauses playback. 

24  

Select the beat length to jump from the current position when clicking  and  

 2 Player mode 

 Please see [1 Player mode] for the contents which are not explained here. 

 

 Function panel show/hide button 

Click this icon to show or hide the Function panel. 

 MEMORY 

Stores cue and loop points that have been set. 

 BEAT SYNC MASTER 

[MASTER] is displayed on the Master Player for Beat Sync. 

 TEMPO Adjustment 

Adjusts the track playing speed. 

  

Click this icon if two tracks in Player A and B are in a good match. 

 BEAT SYNC 

Turns on the beat sync function. 
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 Pitch bend 

Keep pressing these buttons for pitch bend while playing the track. Hold  to speed up 

and hold  to slow down. 

 TEMPO RESET 

Resets the tempo to the original BPM. 

 MASTER TEMPO 

Toggle this to turn the master tempo function on and off. 

 Crossfader 

Adjusts the mix balance of Player A and B. 
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4.3.2 The sub-panel for the loaded track 

 MEMORY panel 

Lists all the saved cue and loop points. 

 

  

When you save a loop point, this icon appears. 

Click this icon to set an active loop (4.6.1 Saving cues or loops); then, the icon turns red. 

 MEMORY 

Click this icon to show the [MEMORY] panel in the sub-panel. 

 Cue/Loop Call button 

Shows (minute/second/millisecond) where a cue or loop point is set. 

Click the time to jump to each cue or loop point. 

 Cue/Loop Delete button 

Deletes saved cue or loop points. 

 Comment 

Shows comments of saved cues or loops. You can edit them. 

Right click to change the cue marker color. 
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 HOT CUE panel 

All the saved hot cues are listed. 

 

 [A], [B], [C] 

Displays HOT CUE [A], [B] and [C]. If a green icon is lit, a cue is saved there, if an orange 

icon is lit, a loop is saved and if an icon is dimmed in gray, it is empty. 

 When number of Hot Cues is set as four in [Preferences], [D] is displayed. 

 Hot Cue save/call button 

Shows (minute/second/millisecond) where a hot cue point is set. Click the time to jump to the 

saved hot cue point. 

If it is empty, click this button, and Hot Cue will be saved. 

 HOT CUE DELETE button 

Deletes the stored hot cue. 

 HOT CUE 

Click this icon to show the HOT CUE panel in the sub-panel for the loaded track. 

 Comment 

Shows a comment of stored hot cues. You can edit them. 
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 INFO panel 

Displays information of a track loaded to the player. 

 

 Track information display 

Displays detailed information of the track loaded to the player. 

 INFO 

Click this icon to show the INFO panel in the sub-panel for the loaded track. 

4.3.3 Function panel 

Click the buttons to switch the function panel between [CUE/LOOP] and [GRID]. 

 CUE/LOOP panel 

Sets and saves Hot Cues Loops and Cues 

 

 CUE/LOOP 

Click this icon to open the CUE/LOOP panel in the function panel. 

 HOT CUE DELETE 

Deletes the stored hot cue. 

 HOT CUE (A, B, C) 

Hot cues are stored here. 
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 LOOP IN/LOOP OUT 

Sets real-time cues and loop in/out points. 

 RELOOP/EXIT 

Cancels or resumes loop playback. 

 Auto Beat Loop (1/32, 1/16, 1/8, 1/4, 1/2, 1, 4, 8, 16, 32) 

Sets the loop length by the specified number of beats. 

 /2 

Click this icon to halve the length of the currently playing loop. 

 x2 

Click this icon to double the length of the currently playing loop. 

 MEMORY 

Stores cue and loop points that have been set. 

  

Jumps to a saved cue or loop point. 

 Click  to jump to the next cue or loop point. 

 Click  to jump to the previous cue or loop point. 

 Cue/Loop Delete button 

Click this icon to delete a saved cue or loop position. 

 GRID panel 

Adjusts beat grid. 

 

 GRID 

Click this icon to open the [GRID] panel. 
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Metronome sound comes with the playing track in sync with the beat grid. 

Click this button to adjust volume of metronome in three levels.  

  

Undoes what you did last in the GRID panel. 

  

Narrows beat grid distance by 1 msec. 

  

Widens beat grid distance by 1 msec. 

  

Moves the beat grid 1 msec to the left. 
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The entire beat grid is slid to match the nearest beat position to the current playback position 

shown in a white vertical line at the center of the waveform. 

  

Moves the beat grid 1 msec to the right. 

  

Doubles the BPM. (The length of each beat grid distance is narrowed by half.) 

  

Halves the BPM. (The length of each beat grid distance is doubled.) 

  

Cancels the temporarily marked position for adjusting the beat grid. 

  

Temporarily marks the base position for adjusting the beat grid points from the position. 

  

Enter BPM value manually to change beat grid distance. 
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Click this icon to manually set BPM. 

4.3.4 Browser panel 

 

 Shortcut 

Drag a folder or a playlist in Tree View, and drop it in a slot to make a shortcut. 

 Playlist path 

This icon will appear if a track highlighted in the track list is stored in playlist(s). Click  to 

show a list of playlist path(s). 

 Playlist Palette 

If you click the  icon, a tag list or four playlists will be displayed. 

 Three palettes on the right among the 4 palettes are the playlist palettes. The far left 

palette is used as Tag List. 

 Artwork switch 

Click one of the following buttons to select the artwork mode. 

: Shows upper part of the artwork. 

: Shows the whole artwork. 

 Category filter 

Searches for music files using the category filter. 
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 My Tag filter 

Click to show My Tag filter and search track files using My Tag added to them. 

 Search filter 

Searches for music files using the search filter. 

 Column header 

Sorts and enables searching of music file information. 

The display of column headers can be turned on and off and their order can be changed. 

 My Tag 

Click the icon to display My Tag settings pane on the right side of track list. 

 RELATED TRACKS 

Click the icon to show tracks suggested to be played next in the right side of track list. 

 Info 

Click to open the information pane on the right side of the track list to show the currently 

selected music file. 

 Track list 

Displays music files in a playlist selected in the tree view. 
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 Tree View 

Select an item to be displayed in the track list. 

Collection Displays all the music files imported to rekordbox. 

Playlists 
You can organize the music collection on rekordbox by creating a Playlist 

prior to performance. 

Hot Cue Bank 

Lists 

Hot cue points you have set even in different tracks can be saved 

in A, B and C of hot cue bank. 

iTunes iTunes library can be referred to and displayed. 

rekordbox xml rekordbox XML for mat can be referred to and displayed. 

Explorer 
Displays folder layers of your computer and external devices such as a USB 

flash drive. 

Devices Displays USB devices, SD cards and mobile devices. 

Histories Displays playback histories on DJ equipment. 

Whether [Hot Cue Bank Lists], [iTunes], [rekordbox xml] and [Explorer] are displayed or hidden 

can be selected in [View] > [Layout] in the [Preferences] screen. 

 Sync Manager 

Click this icon to open the Sync Manager panel to sync rekordbox with external libraries. 

 LINK 

Enables communications with DJ units (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, 

CDJ-900, CDJ-900, XDJ-1000, XDJ-RX, XDJ-AERO) connected by LAN cable or wireless 

LAN. 

 The button is displayed only when rekordbox is connected to DJ units via LAN.  
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4.3.5 Link status panel 

   When rekordbox is connected to DJ units via LAN, Link Status panel appears.    

 

 LINK 

Terminates communications with DJ units (e.g. CDJ-2000nexus, CDJ-2000, CDJ-

900nexus, CDJ-900, XDJ-1000, XDJ-RX, XDJ-AERO) connected by LAN cable or wireless 

LAN. 

 Sync master 

Synchronizes using the master BPM (tempo) specified by rekordbox when you use DJ 

equipment (e.g. CDJ-2000nexus) using the beat sync function. 

 Master BPM 

Specifies the tempo (BPM) used for the sync master. 

 Link Status 

Displays the status of DJ equipment (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-

900, XDJ-AERO) connected by LAN cable or wireless LAN at the bottom of the browser panel. 
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4.4 Launching rekordbox 

Log on as the user which was set as the computer’s administrator before using rekordbox. 

 For Mac OS X 

Open the [Application] folder with Finder, then double-click [rekordbox]. 

 

 For Windows® 8.1, Windows® 8, Windows® 7 

Double-click the [rekordbox] icon (shortcut) on the desktop. 
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4.5 Listening to music files 

Playback music files in the player panel and check its beat and tempo (BPM). 

 

4.5.1 Playing a music file 

1 Drag and drop a music file to the player from the track list. 

The track is now loaded to the player. 

2 Click [ ]. 

Playback starts. 

 Jumping from the current position 

1 Click . 

The dropdown menu is shown to select how many beats to jump. 

2 Select the number of beats. 

How many beats or bars to jump is now selected by clicking . 

3 Click . 

The current position is jumped. 
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 When  is clicked during the LOOP status, not only the current position but also 

the LOOP IN points and LOOP OUT points are jumped. 

 Listening to music files directly on the browser panel 

Playing a music file by clicking the waveform in the [Preview] column 

Click the waveform to start playback from the position you clicked. Click the stop button to the left 

of the waveform to stop it. 

 

When the playback begins in the [Preview] column while another track is played in the player 

panel, the playback in the player panel pauses. 

Playing a music file by clicking the artwork in the [Artwork] column 

Click the artwork to start playback from the beginning of the music file. 

 

 Move the mouse cursor out of the Artwork to stop. 

Click on the Artwork during playback will skip ahead by 30 second increments. 

 

When the playback begins in the [Artwork] column while another track is played in the player 

panel, the playback in the player panel pauses. 

Displaying Cue Marker in Preview waveform 

 

Cues and Hot Cue Markers can be displayed on preview waveform in the track list, allowing you 

to check Cue status of the track in the track list window without loading the track on the player 



78 

 

panel. To do this, open [Preferences] > [View], then tick [Display Cue Markers on Preview]. Click 

in the vicinity of Cue Marker on preview waveform and then playback of the track will be started 

from the Cue Point in the preview. 

 Triggering Play/Pause and CUE in the enlarged waveform 

Using the mouse on the enlarged waveform will trigger the same behavior as clicking the [ ] 

and [CUE] buttons. 

 

 Click anywhere within the enlarged waveform to trigger the same behavior as clicking 

on the [ ] button. 

 Right click anywhere within the enlarged waveform to trigger the same behavior as 

clicking the [CUE] button. 

 

To enable/disable this function, click  button on the right of the enlarged waveform and 

select [On/Off] at [Click on the waveform for PLAY and CUE] in the drop-down menu.  

*In PERFORMANCE mode, Open [Preferences] > [View] > [Click on the waveform for PLAY and 

CUE] and select On/Off. 

 

 Changing color of waveform                             

Click  button on the right of the enlarged waveform and select Blue/RGB in [Change 

waveform color]  

*In PERFORMANCE mode, Open [Preferences] > [View] > [Wave] and select Blue/RGB. 

 

 Changing Beat Count Display 

You can change the way to count beat displayed in the center of enlarged waveform.  

Click  button on the right of the enlarged waveform and select one of the followings in [Beat 

Count Display]  

 Current Position (Bars) 

Displays the number of bars from the beginning to the current playback position. 



79 

 

 Count to the next Memory Cue (Bars) 

Displays the number of bars from the current playback position to the next Memory Cue. If 

the next Memory Cue does not exist, nothing is displayed. 

 Count to the next Memory Cue (Beats) 

Displays the number of beats from the current playback position to the next Memory Cue. If 

the nearest Memory Cue does not exist, nothing is displayed. 

 

*In PERFORMANCE mode, Open [Preferences] > [View] and select from the three options 

mentioned above at [Beat Count Display]. 

 

4.5.2 Checking the beat (beat grid) 

1 Click  among  on the upper right of the screen. 

One player is shown in the Player panel. 

2 Drag the music file from the browser panel to the player panel. 

The music file is loaded into the player panel. 

3 Click [ ]. 

Playback starts. 

 The BPM display shows the tempo measured when the music file was added. 

 The enlarged waveform display shows the beat grid in a white line which is generated 

when the music file is added (beat grid). 

 On the enlarged waveform display, the beats at the beginning of measures are indicated 

on the beat grid as a red line every four beats from the start to the end of the track. 
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 appears to a music file that was previously analyzed by older version of rekordbox. 

This means information of the music file is insufficient or old. Right-click the music file 

and click [Analyze Missing Data], then the information is updated and  disappears. 

 

 Adjusting the beat grid 

The enlarged waveform displays the beat grid with white lines. The beat grid can be adjusted by 

the following procedure. 

 

1 Click [ ] during playback. 

Playback pauses. 

2 Drag the enlarged waveform display to the left or to the right. 

Adjust so that the beat matches the vertical white line at the center of the enlarged waveform 

display. 

3 Click [GRID]. 

Beat grid adjustment menu’s icons appear in the function panel. 

The white lines showing the beat grids turn to blue, and editing becomes possible. 

4 Click . 

The current position moves to the nearest beat position at the center of the waveform, which 

is a white vertical line. The entire beat grid is slid with this move. 

The beat at the center becomes the first beat of the bar and it is shown as a red line. 

 If you wish to slide the beat grid beyond a specific point, click . Beat grid points 

passed through the center vertical line (already played part of the track) are locked, and 

only beat grid points coming to the center vertical line will slide. 

5 Click [GRID]. 

The beat grid adjustment menu closes. 
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 Other icons (beat grid adjustment menu) 

 

Moves the beat grid 1 msec to the left． 

 

Moves the beat grid 1 msec to the right. 

 

Reduces beat grid intervals by 1 msec. 

 

Expands beat grid intervals by 1 msec. 

 

Doubles the BPM value. (The length of each beat grid interval is reduced by half.) 

 

Halves the BMP value. (The length of each beat grid interval is doubled.) 

 

This button is used to make adjustments from the current position. It temporarily 

marks the base position for adjusting the beat grid points. Only the beat grid points 

coming to the mark (positioning right, in a track to be played) are able to slide based 

on the marked position. The beat grid points passed through the mark (positioning 

right, already played in the track) are displayed as white dots, while the beat grid 

points coming to the mark are displayed as blue bars. The blue bars indicate that 

the beats have been adjusted and slid. 

Until the mark is canceled, operations performed at the beat grid adjustment menu 

are only reflected on the beat grid points displayed as blue bars after the mark. 

 

Cancels the temporarily marked position for adjusting the beat grid. When it is 

canceled, all the beat grid points are displayed as blue bars. Operations performed 

at the beat grid adjustment menu are reflected on the whole track. 

 

Undoes operations performed at the beat grid adjustment menu. 

 

Plays track with a metronome in sync with the beat grid. Switches the metronome 

sound on and off and the metronome’s volume (high, medium and low). 

 

Enter the number to change the BPM value. The distance of beat grid changes.  
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During playback, click the [TAP] button several times to manually set BPM. 

 Re-analyzing tracks to detect beat positions and BPM 

1 Open [Preferences] > [Analysis], then select mode for analyzing waveform 

information of music files: [Normal] or [Dynamic]. 

2 Right-click a music file, then select [Analyze Track]. 

The waveform data of the music file is analyzed. The detected beat position and the 

measured BPM are saved on the computer. 

When music files are re-analyzed, the beat grid set at Adjusting the beat grid is overwritten with 

the beat grid newly analyzed with the [Analyze Track] function. 

 

4.5.3 Analysis Lock 

You can limit re-analysis and edit of beat grid on the track basis to prevent grid-adjusted tracks 

from mistakenly overwritten.  

 The effect of Analysis Lock  

In the Analysis Lock mode, the following operations will not be active. 

 Analyze Track 

 Analyze Key 

 All grid editing operation 

When a number of tracks are selected to analyze in a track list, Analysis-Locked tracks are 

skipped. 

 

 How to lock/cancel Analysis Lock mode 

The following two ways illustrate how to set Analysis Lock mode.  

 Toggle  button, or [Analysis Lock] button, in GRID panel in 1-Player mode. 

The icon changes to , and Analysis Lock mode is active. 

Toggle the button again, and Analysis Lock mode is off. 
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 Right-click the track, select [Analysis Lock] > [On]. 

In the Analysis mode,  icon is shown on the status column (far left column of the 

track). 

 

 Using beat grids (Quantize) 

When setting cues and loops on the player panel, the cue and loop points can easily be set on 

beat. 

1 Click the [QUANTIZE] button on the player panel. 

The [QUANTIZE] button lights up on the player panel. 

2 Set cue or loop points 

 

 Playing on DJ players and DJ mixers with the quantize function 

You can use music files’ beat grids that were detected and adjusted using rekordbox and enjoy  

quantize function when you perform using cues, loops on particular DJ equipment (e.g. CDJ-

2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-1000, XDJ-RX, XDJ-AERO, XDJ-R1).  

If DJ player(s) (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-1000) and a 

DJ mixer (e.g. DJM-2000nexus, DJM-2000, DJM-900nexus) are connected by LAN cable, you 

can use beat grids with quantize function when playing FXs. 

 For instructions on using the quantize function on DJ equipment, see the Operating 

Instructions for each DJ equipment. 

 

4.5.4 Detecting the key 

Right-click (For Mac, Ctrl + click) the music file, then select [Detect Key].  

The waveform data of the music file is analyzed. The detected key can be checked on the 

[Collection], [Information] window, etc. 

The key can be detected simultaneously when adding music files to collections. Open 

[Preferences] > [Analysis] and tick [Enable Key Analysis on import]. 
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4.6 Setting cue or loop points 

This section describes how to set cue and loop points. 

 

 Setting cue points 

1 Click [ ] during playback. 

Playback pauses. 

2 Click [CUE]. 

The cue point is set. The [CUE] button lights up. 

 To start playback from the cue point, click [ ]. 

 When a new cue point is set, the previous cue point is deleted. 

 When a different music file is loaded, the previous cue point is canceled.  

 It is also possible to save cue points. 

 Returning to cue point (Back Cue) 

Click [CUE] during playback. 

The track returns to the cue point and pauses. The [CUE] button lights. 

 To start playback from the cue point, click [ ]. 

 Checking cue point (Cue Point Sampler) 

After returning to the cue point, long-click the [CUE] button. 

Playback starts from the cue point. 

Playback continues while [CUE] is pressed. When released, playback returns to the cue point 

and pauses. 

 Setting cue point during playback (Real Time Cue) 

Click the [IN] button (Loop-in button) during playback at the position where you 

wish to set the cue point. 

The point is set as the cue point. 
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When the [QUANTIZE] button is clicked, this button lights up. 

When a real time cue is set after turning on [QUANTIZE], the cue point is automatically set to the 

nearest beat grid when [IN] is clicked. 

 Starting loop playback 

1 Click the [IN] button for loop-in during playback at the position (Loop In Point) 

where you wish to start loop playback. 

The point is set as the Loop In Point. 

 This operation is not necessary if you wish to set the current cue point as the Loop In 

Point. 

2 Click [OUT] at the position (Loop Out Point) where you wish to end Loop 

playback. 

The playing point is set as the loop-out point, the track returns to the loop-in point and loop 

playback starts. 

 When the loop point is set, the previous loop point is deleted. 

 When a different music file is loaded, the previous loop points are canceled. It is also 

possible to save loop points. 

 

When [QUANTIZE] is clicked, the button lights up. 

When a loop is set after turning on [QUANTIZE], the loop point is automatically set to each nearest 

beat grid when [IN] or [OUT] is clicked.  
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 Canceling loop playback (Loop Exit) 

Click [EXIT] during loop playback. 

Playback exits the loop and continues normally. 

 Resuming loop playback (Reloop) 

Click [RELOOP] during playback after loop has already exited. 

Playback returns to the previous loop and loop playback starts. 

 Specifying the loop time in number of beats (Auto Beat Loop) 

You can play a loop with the loop length between 1/32 and 32 beats in accordance with 

the BPM of the playing music file. 

Click the number of beats as the loop length you wish to play during playing a 

track. 

The loop-in and loop-out points are set according to the selected number of beats. 

 When Auto Beat Loop (the number of beats) is set during loop playback, the current loop-

in point is maintained, and only the loop-out point is moved. 

When the [QUANTIZE] button is clicked, the button lights up. 

When Auto Beat Loop is set after turning on the [QUANTIZE] button, the loop points are 

automatically set to the nearest beat grid points. 

 Export loops and saving them as WAV files  

To export loops and save them as WAV files, click  to the right of the enlarged 

waveform on the player panel while the loop is playing and select [Export Loop As 

Wav]. 

 Exported loops are saved as WAV files (48 kHz sampling frequency, 16-bit quantization) and 

added to the rekordbox music collection. The specified file name when it was saved is shown 

in the title in [Collection]. 

 For instructions on using saved loops (WAV files), see the Operating Instructions of each DJ 

equipment (e.g. RMX-1000, XDJ-AERO). 
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4.6.1 Saving cues or loops 

You can set, save and call up cue and loop points. Up to 10 cue or loop points can be saved per 

music file. 

Saved cue and loop points can be called and played on DJ equipment (e.g. CDJ-

2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, CDJ-850, XDJ-1000, XDJ-RX and MEP-4000). 

 

 Setting and saving cue and loop points 

1 Set cue or loop point. 

2 Click [MEMORY]. 

 

The time of saved cue/loop points in (minute/second/millisecond) are shown in the sub-panel 

for the loaded track. 

 Click [MEMORY] during loop playback to save a loop point. The time of loop points in 

(minute/second/millisecond) are shown in the sub-panel for the loaded track. 
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 Calling saved cue or loop points 

1 Load the music file containing the cue or loop points you wish to call into the 

player panel. 

The time of saved cue/loop points in (minute/second/millisecond) are shown in the 

MEMORY panel in the sub-panel for the loaded track. 

2 Click the cue/loop call button to start playback from the cue/Loop point. 

 

The playback position is moved to the selected point and the play pauses. 

 Click  to jump forward to a saved cue or loop point from the currently playing 

position. 

 Click  to jump backward to a saved cue or loop point from the currently playing 

position. 

3 Click [ ]. 

Playback or loop playback starts. 

 To delete the cue point or loop point, click [ ] on the right side of the Cue/Loop 

Call button. 

 Setting a saved loop as the active loop 

When a loop point is saved, a loop icon  is displayed on the left side of Cue/Loop Call button. 

To set the loop as an active loop, click . 

When the loop is set as an active loop,  turns to . 

If you click the menu button in the right of enlarged waveform of the player panel and 

select [On] in [Active Loop Playback], loop playback automatically starts at the point of 

active loop when you play a track on players supporting active loop function. Using 
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rekirdbox, you can check how active loop is performed on CDJs and XDJs.  

For instructions on active loops, see the Operating Instructions of each DJ equipment 

(e.g. CDJ-2000nexus).  

 

 Adding comments to cue and loop points 

Your comment can be added in the column on the right side of the Cue/Loop Call button in the 

sub-panel for the loaded track. 

Click the Comment column to enter your comment. Then, press [Enter]. 

 

 Changing colors of cue markers displayed above the waveform 

 

The color of the cue markers displayed above the waveform can be changed. 

Right-click the comment column to the right of Cue/Loop Call button in the sub-panel for the 

loaded track and select a color in the Color dropdown menu. 

 Comments and colors added to cues can be shown on certain DJ equipment (XDJ-1000, 

and XDJ-RX). 
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4.8 Organizing hot cue by using Hot Cue Bank List 

  XDJ-1000 

The cue/loop point information for different music files can be stored in Hot Cue Banks. The 

combination of the three hot cue banks (A, B, C) is called Hot Cue Bank List. Using multiple Hot 

Cue Bank Lists, you can raise the bar on your DJ performance with a variety of hot cue 

combination. 

 Hot Cue Bank Lists cannot be loaded onto some DJ equipment (e.g. CDJ-

900nexus, CDJ-900, CDJ-850, CDJ-350, MEP-4000, XDJ-RX, XDJ-AERO, XDJ-R1). 

 In 2-player mode, Hot Cue Bank buttons and the delete buttons are not displayed 

 In PERFORMANCE mode, Hot Cue Bank List is not displayed. 

 

 

 Creating a new Hot Cue Bank List 

1 Click  to the right of the [Hot Cue Bank Lists] folder. 

[Untitled Hot Cue Bank List] is created under the [Hot Cue Bank Lists] folder. 

2 Click the name (initially “Untitled Hot Cue Bank List”) on Tree View and enter 

the list’s name and press the [Enter] key. 

The name of the Hot Cue Bank List is changed. 

 To delete a Hot Cue Bank List, select the Hot Cue Bank List then press the [Delete] 

key. 

 

 Saving cues and loop points as Hot Cue Banks 

During the play or pause mode, click one of the Hot Cue Bank buttons (A, B or C) 

in the Hot Cue Bank List at the position you wish to save. 

The cue point is stored in a Hot Cue Bank. The information of the saved cue (title, artist and 

time) is displayed beside the Hot Cue Bank button (A, B or C). 

 When a Hot Cue Bank button is clicked during a loop playback, the currently playing loop 

point will be stored in a Hot Cue Bank. 
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 Checking saved Hot Cue Banks 

Click the Hot Cue Bank button of the saved cue/loop point.  

Playback starts from the cue/loop point saved at the button. 

 To delete a cue/loop point saved in the Hot Cue Bank List, click [ ] in the Hot Cue 

Bank. 

 Calling already saved hot cues and save them in Hot Cue Bank 

1 Load a music file containing hot cue points into the player panel. 

Click [HOT CUE] in the sub-panel for the loaded track. The cue or loop points saved in the 

track are displayed.  

2 Click [ ] if you are playing the track to pause. 

3 Click [HOT CUE] you wish to save in the Hot Cue Bank. 

The playback position is moved to the selected point and the play pauses. 

4 Click one of the Hot Cue Bank button (A, B or C) 

The hot cue point is saved in the Hot Cue Bank. 

 Organizing Hot Cue Bank Lists by using folders 

1 Right-click the [Hot Cue Bank Lists] folder and select [Create New Folder]. 

[Untitled Folder] is created under the [Hot Cue Bank Lists] folder. 

2 Click the name (initially “Untitled Folder”), input the folder’s name and press the 

[Enter] key. 

3 Drag Hot Cue Bank Lists to the newly created folder. 

Hot Cue Bank Lists are moved under the newly created folder. 

 To delete a folder, select the folder then press the [Delete] key. All Hot Cue Bank lists and 

folders contained in that folder are deleted. 

 

 Adding an artwork image to a Hot Cue Bank List 

The artwork image file formats which can be added are JPEG or PNG (extensions: “jpg”, “jpeg”, 

“png”). 
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1 Right-click a Hot Cue Bank List and select [Add Artwork]. 

The [Select an artwork] screen opens. 

2 Select the folder and the image file you wish to add then click [Open]. 

The artwork image is added to a Hot Cue Bank List. 

The artwork image appears when the Hot Cue Bank List is right-clicked. 

4.9 Using 2-Player mode to prepare for mixing 

Enjoy mixing tracks to check good match combination or adjust beat grids. 

A good match combination of tracks can be saved in the library and they can be called as related 

tracks when selecting the next track to play. 

 

 Mixing 2 tracks in Player A and B 

1 Click  at the top right of the screen. 

The player panel is switched to 2-Player mode. 

2 Drag a music file to Player A. 

The music file is now loaded to Player A. 

3 Drag a music file to Player B. 

The music file is now loaded to Player B. 

4 Click [ ] on Player A and Player B. 

The tracks start playback. 
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5 Adjusting the mixing audio volume of Player A and Player B. 

You can try mixing with a crossfader. 

Move the crossfader between Player A and B to mix the sound. 

 

 Displaying the function panel 

Click  on the left side of the player to show/hide the function panel to save cue points, 

playing loops and adjusting the beat positions. Click  again to hide the function panel. 

 

 

 Adjusting the playback speed of the music file (Tempo control) 

You can match the playback speed of two music files. 

 

Click the TEMPO adjustment button. 

You can change the playback speed of the music file in the player panel. 

 Click , and the playback speed will become faster. 

 Click , and the playback speed will become slower. 

 Click [RST], and the playback speed will be reset to the original speed. 

 Click the BPM field to directly change the BPM. 
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 Adjusting the playing speed without changing the pitch (Master Tempo) 

1 Click the [MT] (Master Tempo) button. 

The mater tempo button lights up. 

2 Click the TEMPO adjustment button. 

 The pitch of the track does not change even when you change the playback speed by the 

TEMPO adjustment button. 

The sound quality may differ because the sound is digitally reprocessed. 

 

 Adjusting the beat positions of two tracks manually using Pitch Bend 

Click  or  during playback. 

 Click  while playing a track, and the playback speed continues slowing down as 

long as it is pressed. 

 Click  while playing a track, and the playback speed continues speeding up as long 

as it is pressed. 

 Synchronizing the beat positions and tempo of two tracks using Beat Sync 

1 Play a track on Player A. 

The Player which first begins the playback becomes the Sync Master. 

2 Play a track on Player B. 

3 Click [SYNC] on Player B. 

The Tempo (BPM) and beat positions of the track on Player B will be synchronized with those 

on Player A. 

 Click [SYNC] again, the SYNC function will turn off. 

 To get back to the original BPM on each player after turning the SYNC off, Click [RST]. 

 

 Setting two tracks as a good match combination 

If the two tracks are found as a good match to mix in terms of harmony and other reasons, you 

can store such information in the library. 

The stored information can be shown as a good match combination. 
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Click . 

The icon changes to , and the two tracks are stored as a good match combination to mix. 

 If music files loaded to Player A and Player B are already set as a good match 

combination,  is automatically shown. 

 

To list up and display tracks of good match combination for a particular track, see 3.5.5 Display 

related tracks. To show list of related tracks, select [Matching] at [Criteria] at [Customize the 

criteria] ( ) at related track list window (Matching).  
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4.10 Synchronizing iTunes library and devices with rekordbox using 

Sync Manager 

Sync Manager will allow you to export playlists in iTunes and rekordbox to USB devices in an 

updated status. 

 

Synchronizing with iTunes library 

Once iTunes library is synchronized, information in iTunes library can be used seamlessly 

on rekordbox. 

The synchronized iTunes playlists are updated and shown in [iTunes] in the tree view. 

Tracks in the synchronized playlists are automatically analyzed by rekordbox, and their artwork 

and waveform will be shown. 

 

Synchronizing with devices (USB device or SD card) 

When a device is synchronized, the playlists you selected are exported to the device with the 

updated information. Cues, beat positions and ratings updated on DJ equipment also can be 

imported back to rekordbox. 

 

 Launching Sync Manager 

Click  at the bottom of Tree View to launch Sync Manager. 
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 Selecting iTunes playlists to synchronize with rekordbox 

 

1 Tick the checkbox of [Synchronize iTunes playlists]. 

You can select iTunes folders or playlists to synchronize with rekordbox. 

2 Tick the checkboxes on the right side of iTunes folders or playlists. 

3 Click  on the right side of iTunes playlists. 

The ticked playlist is synchronized with rekordbox. 

When the synchronization is successfully completed, the synchronized playlists appear in the 

tree view of rekordbox of Sync Manager. 
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 Synchronizing playlists in rekordbox or those in iTunes with a device 

 

1 Insert a USB device or an SD card to your computer. 

2 Click  to select a device from the drop-down menu. 

Playlists in the device you selected are now displayed. 

3 Tick the checkbox for [Synchronize playlists with a device]. 

You can select rekordbox folders or playlists to synchronize with the device. 

4 Tick the checkboxes on the right side of rekordbox folders or playlists to sync 

with the device. 

 

5 Click  on the left side of the [Device]. 

The ticked playlist is synchronized with rekordbox. 

When a device is synchronized, the playlists you selected are exported to the device with the 



101 

 

updated information. 

Track information in the playlists is also updated. 

 

 Reflecting information including cues, beat positions and ratings updated on DJ 

equipment to rekordbox 

1 Connect a device which is synchronized with rekordbox to your computer and 

launch Sync Manager. 

2 Click  to select a device from the drop-down menu. 

3 Click  on the left side of [Device]. 

Information in the device is reflected to rekordbox. 

The same results are expected if you select a device in Tree View and select [Update 

Collection]. 

Neither the information of tracks exported from a different computer nor that of tracks deleted 

from the Collection in your rekordbox can be reflected. 
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4.11 Playback with a USB device 

         

You can load tracks and track lists saved in rekordbox Collection to your DJ equipment by using 

USB devices (flash memory or hard disk). 

 For music files (file formats) that can be loaded and played on Pioneer DJ’s DJ equipment, 

see the Operating Instructions for each DJ equipment. 

 In addition to USB devices, SD memory cards can be used for some DJ equipment (e.g. 

CDJ-2000nexus and CDJ-2000). 

 When you use MEP-4000 or XDJ-R1, Open 

[Preferences]→[CDJ&Device]→[Device]→[Library] and select each device to use. When 

USB device is removed after selecting the device, the necessary data for DJ performance 

will be loaded to the USB device. 
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 Connecting the USB device to the computer 

1 Plug the USB device into the computer. 

2 Click  for the USB device you wish to use for the performance. 

The USB device’s settings are displayed in [Devices]. 

 

File systems such as NTFS and exFAT are not supported by DJ equipment, thus they 

are not displayed on the screen. Use FAT32 for Windows and FAT32 or HFS+ formatted 

device for Mac. 

 Connecting mobile devices supporting wireless LAN (Wi-Fi®) 

rekordbox music files can be transferred not only to USB devices and SD memory cards, but 

also to mobile devices (e.g. iPhone, Android™ devices) that support wireless LANs (Wi-Fi®). 

First set the mobile version of rekordbox on the mobile device to the communications standby 

mode, then click  on the right of [Devices]. 

When the mobile devices in the computer’s area are detected and the links are established, 

the names of the mobile devices are displayed on [Devices]. 

 Details on functions that can be used in association with rekordbox on mobile devices and 

their Operating Instructions are provided on the rekordbox online support site. 
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 USB device settings 

The settings can be changed for individual USB devices. 

General 

Device Name 
Sets the name to be displayed when the device is 

connected to the DJ equipment. 

Background 

Color 

Sets the background color to be displayed when the device 

is connected to the DJ equipment. 

Category 

Specifies the category items to be used with the DJ equipment and the order 

in which they are displayed. For more instructions on using the Library Browse 

function of DJ equipment, see the Operating Instructions for each DJ 

equipment. 

Sort 

Specifies the sorting items to be used with the DJ equipment and the order in 

which they are displayed. For more instructions on using the Library Browse 

function of DJ equipment, see the Operating Instructions for each DJ 

equipment. 

Column 

Specifies a user-set category to be displayed to the immediate right of titles 

when browsing music files on the main unit display of the DJ equipment (e.g. 

CDJ-2000nexus). 

Color 

Comments on the color codes used for classifying the categories of music 

files on DJ equipment in eight colors can be edited. For more instructions on 

using the Library Browse function of DJ equipment, see the Operating 

Instructions for each DJ equipment. 

 

4.11.1 Transferring music files to USB devices 

Drag a music file from [Collection] to a device icon  in [Devices]. 

The music file and the information associated with it are transferred to the USB device. 

 Music files can also be transferred by dragging them from [iTunes] and [Explorer] to a 

device icon in [Devices]. 

 To delete the music file from the USB device, select the music file in [Devices], then press 

the [Delete] key on the computer’s keyboard. (The music files while they are transferred 

cannot be deleted.) 

- The progress bar appears at the bottom of the screen while the device is transferred. 

- The music files can be transferred to multiple devices at the same time. 
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For some DJ equipment (e.g. MEP-4000, XDJ-R1) it is necessary not only to transfer the 

music files to the USB device, but also to create an exclusive library (database such as 

Collections, Playlists, etc.) on the USB device. Exclusive library will be created when the 

device is removed. 

 

 Transferring music files to USB devices 

1 Click  to the left of  you wish to transfer the playlist, and then click  to the 

left of the [Playlists] folder. 

2 Drag a playlist to [Devices]. 

The playlist and the music files contained in it are transferred to the USB device. 

 A playlist can be transferred by dragging it from [iTunes] to [Devices]. 

 To delete the playlist from the USB device, select the playlist in [Devices], then press the 

[Delete] key on the computer’s keyboard. 

Depending on the DJ equipment to which the USB device is connected for playback, there may 

be restrictions on the names of playlists and the folder structure on the USB device. For the 

restrictions that may apply when connecting USB devices for playback, see the Operating 

Instructions of each DJ equipment (e.g. MEP-4000, XDJ-R1). 

 

 Transferring Hot Cue Bank Lists to a USB device 

  

You can use combinations of hot cues (A, B and C) of different music files on DJ equipment by 

using Hot Cue Bank list created prior to the performance. 

1 Click  to the left of  you wish to transfer the Hot Cue Bank List, and then 

click  to the left of the [Hot Cue Bank Lists] folder. 

2 Drag the Hot Cue Bank List to [Devices]. 

The Hot Cue Bank List and the music files contained in it are transferred to the USB device. 

 To delete the Hot Cue Bank List from the USB device, select the Hot Cue Bank List in 

[Devices], then press the [Delete] key. 
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 Disconnecting a USB device from the computer 

1 Click  to the right of the  icon to disconnect from the computer. 

2 Disconnect the USB device from the computer. 

 The USB device cannot be disconnected while the data is transferring. If you wish to 

disconnect the device, click  to the right of the progress bar to cancel the data transfer. 

When [Create library exclusively for] is set at the [Preferences] screen,  is displayed 

instead of  to the right of . When  is clicked, creation of a library exclusively for 

the MEP-4000 or XDJ-R1 begins. Wait until this finishes before disconnecting the USB 

device from the computer. 

 

4.11.2 DJ performance using a USB device connected to a DJ equipment 

You can take a USB device (flash memory or hard disk) into the DJ booth to transfer music files, 

play lists, cue point information and other related data saved on rekordbox to DJ equipment you 

use back and forth. 

 SD memory card can be used for some DJ equipment (e.g. CDJ-2000nexus or CDJ-2000) 

instead of a USB device. 

 Hot cue bank lists cannot be loaded onto some DJ equipment (e.g. CDJ-900, CDJ-850, CDJ-

350, MEP-4000, XDJ-AERO and XDJ-R1). 

 For some DJ equipment (MEP-4000, XDJ-R1), the number of tracks displayed in the folders 

and playlists on the USB device is limited. 

 For instructions on connecting USB devices to DJ equipment and using the USB device for 

DJ performance, see the Operating Instructions for each DJ equipment. 

 DJ performance using quantize function on DJ equipment or DJ mixer 

If you detected and adjusted beat grids of music files using rekordbox, you can use quantize 

function on DJ equipment when performing cue operations and playing loops on DJ equipment 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO and XDJ-R1). 

Furthermore, if DJ equipment (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus and CDJ-900) 

and DJ mixer (e.g. DJM-2000nexus, DJM-2000 and DJM-900nexus) are connected by LAN cable, 

you can use quantize function while effect (FX) is active. 

 For instructions on using quantize function on DJ equipment, see the Operating 

Instructions for each DJ equipment. 

 Using the beat sync function between multiple DJ equipment for DJ performance 

If you detected and adjusted beat grids of music files using rekordbox, you can synchronize 
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tempos (BPM) and beats of multiple DJ equipment (e.g. CDJ-2000nexus, CDJ-900nexus) 

connected via PRO DJ LINK. Yu can also synchronize them of the left and right decks of 

controllers (e.g. XDJ-AERO, XDJ-R1). 

 For instructions on using the beat sync function on DJ equipment, see the Operating 

Instructions of each DJ equipment. 

 Using hot cues on a DJ equipment 

The hot cue (A, B and C) information of music files can be called and used on DJ equipment (e.g. 

CDJ-2000nexus or CDJ-2000). 

 For instructions on using the hot cue (A, B and C) information on DJ equipment, see the 

Operating Instructions of DJ equipment. 

 In case of music files with [Hot Cue Auto Load] enabled in [Preferences] > [CDJ&Device] > 

[Hot Cue] tab, hot cues (A, B and C) saved in the music files will be automatically loaded 

when the music files are loaded onto a DJ equipment and overwrite previously set hot cues  

(A, B and C) on the DJ equipment. 

 

 

 Saving playback history on a DJ equipment to rekordbox 

     

Connect the USB device used for DJ performance to the computer. 

The play history of tracks in the device is automatically saved in rekordbox. 

The saved history is displayed in the [Histories] folder with the saved date. 

 The saved history is deleted from the USB device. 
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 When [Import the play history automatically] is disabled in the Preferences: 

1 Open the [Histories] folder in the USB device. 

A list of played histories of DJ equipment is displayed. 

2 Right-click the play history you wish to save and select [Import History]. 

The selected play history is saved in rekordbox. 

The saved play history is displayed in the [Histories] folder with saved date. 

 The saved play history is deleted from the USB device.  

Tracks in the play histories must be the ones exported from Collection in your rekordbox. 

Tracks exported from different version of rekordbox or tracks deleted from your rekordbox 

cannot be saved in the play histories. Such tracks are excluded and the remaining tracks are 

loaded to overwrite existing tracks. 
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 Updating information of music files saved on a DJ equipment 

      

1 Connect the USB device used for DJ performance to the computer. 

2 Right-click on the USB device and select [Update Collection]. 

The [Update Collection with USB Device] screen opens when updating of the music file 

information begins, then closes once the update is completed. 

 The following information is updated. 

- Cue Point and Loop Point 

- Hot Cue 

- Beat Grid 

- Track information (Color, Rating, Comments) 

 If you click [Cancel] during the update process, the [Update Collection with USB Device] 

window is closed. 
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 Loading playlist files created on a DJ equipment 

      

Playlists created on DJ equipment are stored on the USB device. 

Check the playlist in [Devices], then load it into [Playlists]. 

1 Click  to the left of  you wish to load the playlist from, then click  to the 

left of the [Playlists] folder. 

A list of playlists saved in the USB device is shown in [Devices]. 

2 Drag the playlist to [Playlists]. 

The playlist is added to [Playlists]. 

 Playlists can be also loaded by right-clicking on the playlist you wish to load at [Devices] 

and then selecting [Import Playlist]. 

 If there is already a playlist with the same name in [Playlists], a number is added to the 

end of the playlist’s name. (e.g. playlists (1)) 

 

Tracks in the playlist must be the ones exported from Collection in your rekordbox. Tracks 

exported from different version of rekordbox or tracks deleted from your rekordbox cannot be 

saved in the playlist. Such tracks are excluded and the remaining tracks are loaded in the playlist. 
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4.12 DJ performance on DJ equipment connected to LAN 

        

If you connect a computer to the DJ equipment with a LAN cable or by wireless LAN, you can 

directly load the rekordbox music files and data and use them on the DJ equipment. 

 No need to export tracks and data to USB device. 

 You can use various rekordbox features (e.g. track browsing) while you are DJ 

performance.  

When your computer is connected to a PRO DJ LINK-compatible DJ mixer by a LAN cable, you 

can monitor tracks in rekordbox through headphones connected to the DJ mixer. 

 

 Establishing the link (displaying the link status) 

Depending on the security software used on your computer and its operating system’s settings, it 

may not be possible to establish links with DJ units. 

If this occurs, it will be necessary to clear your settings for any programs and communications 

ports that are blocked. 

1 Connect the computer and DJ units. 

When a DJ unit connected to the network is detected,  is displayed at the bottom left 

of the browser panel. 

 For instructions on connections, see the Operating Instructions for each DJ equipment 

and computer. 

 When connected using a switching hub or a PRO DJ LINK-compatible DJ mixer, 

rekordbox music files and data can be shared with up to four DJ equipment. 

 It may take time for the network address to be acquired automatically depending on the 

communications environment. 

2 Click . 

Communications with DJ units connected by LAN cable or wireless LAN are enabled. 

The link status panel (icons of connected DJ units) is displayed at the bottom of the browser 
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panel, and  switches to . 

 When  is displayed to the left of the link status panel, this means that there are 

two computers connected and that there is already another computer on 

which rekordbox is installed in the network. 

 When  is displayed on the left of the link status panel, this indicates that the 

computer is connected to the network by wireless LAN. 

 When [MIDI/HID] is displayed to the right of the DJ unit’s icon, this means that the DJ unit 

is communicating with another computer by USB control (MIDI or HID). 

 Rearranging the DJ units’ icons displayed on the link status panel 

The order in which the DJ unit icons are displayed on the link status panel can be rearranged to 

reflect the actual physical layout of your DJ units by dragging them left and right. 

 Monitoring tracks through headphones connected to the DJ mixer 

   

To monitor rekordbox music files through headphones connected to the DJ mixer, open 

[Preferences] > [Audio] > [LINK MONITOR] and tick [Use “LINK MONITOR” of Pioneer DJ Mixers]. 

1 Drag the music file from the browser panel to the player panel. 

The music file is loaded into the player panel. 

 Music files can also be loaded into the player panel by dragging them from the browser 

panel to the  icon on the link status panel. 

2 Click [ ] on the player panel. 

Playback starts. 

The sound is sent to the DJ mixer over the LAN cable. 

3 Monitor the sound from [LINK] channel of the DJ mixer through headphones. 

 For instructions on operating DJ mixers, see the Operating Instructions for each DJ mixer. 
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 Loading music files onto DJ equipment 

When [EJECT/LOAD LOCK] function of DJ equipment is active, music files cannot be loaded until 

playback on the DJ equipment is paused. 

Drag music files from [Collection] to  on the link status panel. 

The music file is loaded onto the DJ equipment, and playback starts. 

 Music files can also be loaded to the DJ equipment by dragging them from [Playlists], 

[iTunes], [Tag List], [Histories] or [Explorer]. 

 Music files in [Devices] cannot be loaded to the DJ equipment via PRO DJ LINK.  

 DJ performance using quantize function on DJ equipment 

If you detected and adjusted beat grids of music files using rekordbox, you can use them with 

quantize function of DJ equipment when performing cue operations and playing loops on DJ 

equipment (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO, XDJ-R1). 

Furthermore, if DJ equipment (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus and CDJ-900) 

and a DJ mixer (e.g. DJM-2000nexus, DJM-2000 and DJM-900nexus) are connected by a LAN 

cable, you can use quantize function while effect (FX) is active. 

 For instructions on using quantize function on DJ equipment, see the Operating 

Instructions for each DJ equipment. 

 Using beat sync function between multiple DJ equipment for DJ performance 

If you detected and adjusted beat grids of music files using rekordbox, you can sync tempos 

(BPM) and beats of multiple DJ equipment (e.g. CDJ-2000nexus, CDJ-900nexus) connected 

via PRO DJ LINK. Yu can also sync them of the left and right decks of controllers (e.g. XDJ-

AERO, XDJ-R1). 

 For instructions on using the beat sync function on DJ equipment, see the Operating 

Instructions of each DJ equipment. 

 

 You can sync tempos (BPM) and beats of multiple DJ equipment (e.g. CDJ-2000nexus, CDJ-

900nexus) by specifying tempos (BPM) on rekordbox. 
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 Using hot cues on DJ equipment 

The hot cue (A, B and C) information of music files can be called and used on DJ equipment (e.g. 

CDJ-2000nexus or CDJ-2000). 

 For instructions on using the hot cue (A, B and C) information on DJ equipment, see the 

Operating Instructions of each DJ equipment. 

 When [Hot Cue Auto Load] is enabled in [Preferences] > [CDJ&Device] > [Hot Cue] tab, and 

such music files are loaded to DJ equipment, hot cues (A, B and C) saved in the music files 

will be automatically loaded and overwrite previously set hot cues (A, B and C) on the DJ 

equipment. 

 

 Loading the Hot Cue Bank Lists into the DJ equipment 

  

You can use combinations of hot cues (A, B and C) of different music files on DJ equipment by 

using Hot Cue Bank Lists created prior to the performance. 

Drag the Hot Cue Bank List from the [Hot Cue Bank Lists] to  in the link 

status panel. 

The Hot Cue Banks (A, B and C) stored in the Hot Cue Bank Lists are loaded into the hot cues 

(A, B and C) of DJ equipment. 

 

 Sharing music files by using Tag List 

     

The tag list is a list allowing you to perform real-time browsing from each of the DJ equipment 

which are displayed in the link status panel. 

When music files are added from rekordbox to the tag list, the music files on the tag list can be 

loaded onto the DJ equipment and played by operating the DJ equipment. 

1 Click  above the tree view and then click  on the right. 

 In order to show the tag list, you need to tick [Playlist Palette] in [Preferences] > [View] > 

[Layout]. 
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2 Drag a music file from [Collection] to [Tag List]. 

The music files are added to [Tag List]. 

 Or, right-click a music file and select [Add to Tag List]. 

 Music files and playlists can also be added by dragging them from [Playlists] or [iTunes]. 

 Up to 100 files can be added. 

 Changing the order of the tracks on the tag list 

1 Toggle the heading of the column displaying the track order. 

Each time you toggle, the arrangement toggles between ascending and descending orders. 

2 Drag a music file and change the track order. 

If the songs are sorted by any column header besides that which represents the track order, a 

music file cannot be dragged and the list cannot be reordered. 

 Playback on a DJ equipment by using Tag List 

By operating the DJ equipment, the music files on the tag list can be loaded into and played 

on each DJ equipment, and tag lists actually used during performances can be saved 

as rekordbox playlists. 

 For instructions on accessing the tag lists from the DJ equipment, see the Operating 

Instructions for each DJ equipment. 

 Checking the play history 

You can check music files that played on DJ equipment connected by LAN cable or wireless LAN 

and their playing order in [Histories]. 

1 Double click [Histories] in Tree View. 

Histories appear by folders with year and month. 

Histories of playback through PRO DJ LINK are created with a name of [LINK HISTORY yyyy-

mm-dd] in a folder of the year and month. 

2 Select [LINK HISTORY yyyy-mm-dd]. 

A list of music files in a history is shown in the track list. 
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 Disconnecting links 

Click . 

Communication with DJ units (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-

900, DJM-2000nexus, DJM-2000, DJM-900nexus, XDJ-AERO) connected by LAN cable or 

wireless LAN are terminated. 

 

4.13  Setting preferences 

To change rekordbox settings, select [Preferences] from the [File] menu to open the 

[Preferences] screen. 

Preferences: View  

Language Sets the language to be used in the display. 

Browse 

Font Size Sets the size of the characters. 

Line Space Sets line space of track lists. 

Artwork 
Selects the size of artwork displayed on the track list and tag list. 

(Active only when the whole artwork is shown) 

Show the 

selected 

track to the 

center 

Tick the checkbox if you wish to show the selected track to the 

center. 

Layout 

Tree View 
Selects whether or not [Hot Cue Bank List], [iTunes], [rekordbox 

xml] and [Explorer] are displayed in Tree View. 

Playlist 

Palette 
Selects whether or not the Playlist Palette is displayed. 

Display 

Cue 

Markers in 

Preview 

Selects whether or not memory and hot cues are displayed in the 

waveform in the preview column. 

Tooltips Sets whether or not tooltips are displayed. 
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Waveform 

 

Waveform 

Drawing 

Rate 

Sets drawing rate of waveform. The higher the speed, the better 

the quality of waveform. However CPU load increases. 

Color Select Blue or RGB. 

Full/Preview 

Waveform 
Select Full/Half. 

Player 
Number of 

Hot Cues 
Select 3 or 4 (For XDJ-RX). 

Beat count 

Display 

Sets count display to the current position or count display to the next Memory 

Cue.  

Click 

waveform 

for 

PLAY/CUE 

Sets whether or not set [Play], [Pause] [Current Cue] by clicking enlarged 

waveform. 

Left-click: play/pause 

Right-click: setting current cues, starting playback from cue points 

 

Preferences: Audio 

LINK MONITOR 
Sets whether or not to monitor rekordbox music files over the 

headphones of the DJ mixer connected by PRO DJ LINK. 

Metronome 
Sets the tone of the metronome while you are monitoring beat grids 

of music files. 

Audio Sets the audio output device. 

Sample Rate 

Sets the sampling frequency of audio data sent to an audio device. 

Higher sampling rate allows you to achieve a playback quality 

closer to that of the original track. However, as the amount of audio 

data increases, the load on the audio device also increases. 

Buffer size 

Sets the number of samples sent to an audio device for each data 

transmission. 

A large buffer size reduces audio skipping (audio interruption). 

However, as the transmission delay (latency) increases, the time 

gap also increases between the playback position of the music file 

displayed on the screen and the actual audio output. 
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Output channels 
Sets audio output channel when there are multiple outputs from an 

audio device. 

 

Preferences: Analysis 

Track 

Analysis 

 

Track Analysis Mode 

Sets the mode for analyzing the music file’s waveform 

information. 

 Normal: Suitable for analysis of tracks which have a 

relatively consistent tempo 

BPM Range: Sets BPM range obtained by normal 

analysis 

 Dynamic: Suitable for analysis of tracks which contain 

significant tempo changes 

Sets Memory Cue at 

the first beat when 

analyzing 

Tick the checkbox if you wish. 

“PIONEER” Folder 

(analysis files) 

Sets where to store the wave information of the analyzed 

music files. 

Key 

Analysis 

Enable Key Analysis 

on import 

Tick the checkbox if you wish to detect keys when adding 

music files to Collection. 

Write the value to the 

ID3 tag 
Detected key is stored in ID3 tag. 

Analysis 

Process 

Sets concurrent process mode. “Performance” mode allows high speed analysis, 

although CPU load increases. 
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Preferences:  CDJ& Device 

Category 

Specifies the category items to be used with the DJ equipment and the order of 

display. For more instructions on using Library Browse function of DJ 

equipment, see the Operating Instructions for each DJ equipment. 

Sort 

Specifies the sorting items to be used with the DJ equipment and the order of 

display. For more instructions on using Library Browse function of DJ 

equipment, see the Operating Instructions for each DJ equipment. 

Column 

Specifies a user-set category to be displayed to the immediate right of titles 

when browsing music files on the main unit display of the DJ equipment 

(e.g. CDJ-2000nexus). 

My Settings 

The settings of DJ equipment can be saved in rekordbox and reflected to DJ 

equipment through a USB device, a mobile device or PRO DJ LINK. This lets 

users immediately set up DJ equipment with the settings they are used to so 

they can devote all their attention to their performance. For details of the items 

of setting that can be stored and called at “My Settings”, see the Operating 

Instructions of each DJ equipment (e.g. CDJ-2000nexus). 

HOT CUE 
Prepare Hot Cue Auto Load setting for 

CDJ use (on import) 

If you tick it, [Allow to auto load 

HotCue on CDJ] on the [Information] 

panel in the information window is 

automatically ticked. When music files 

with this setting are loaded into DJ 

equipment (e.g. CDJ-2000nexus, XDJ-

R1), cue points saved on the DJ 

equipment are replaced with the cue 

points saved in the loaded music files. 

Device Library 

Create library 

exclusively for a 

selected device 

Sets whether or not to create libraries 

(databases such as Collections, 

Playlists, etc.) exclusively for certain 

devices. When the device is 

disconnected from the computer, 

exclusive library is created on the 

device. When [Create 320×320 pixels 

size image] is ticked, you can export 
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track information with 320 x 320 pixel 

artwork to a device (only for XDJ-R1). 

Delete Tracks 

Delete playlist 

tracks from device 

if playlist is 

deleted 

When a playlist is deleted in [Devices], 

the playlist in a USB device or an SD 

card is deleted. You can select 

whether the music files in the USB 

device or an SD card is deleted or not 

when the playlist is deleted. 

Music files are deleted only if they are 

not being used by other playlists. 

History 

Import the play 

history 

automatically 

Sets whether or not histories of tracks 

played on CDJ are automatically 

added to [Histories] when a device is 

inserted. 

 

Preferences: Keyboard 

Keyboard Assigns keyboard shortcuts to each button. 
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Preferences: Advanced 

Database 

iTunes 

iTunes Library File 

Specifies the xml file of 

the iTunes library to browse in 

[iTunes]. 

Convert iTunes “Grouping” to 

rekordbox “Label” 

Sets whether or not to 

store iTunes group information 

as rekordbox label information 

when importing music file 

information from 

the iTunes library to 

the rekordbox Collection. 

rekordbox xml 

Export Beat Grid information 

Sets whether or not to export the 

beat position information 

of rekordbox to an xml file when 

the rekordbox library information 

is exported. 

Imported Library 

Specifies the playlist library (the 

location of the xml file) to browse 

in [rekordbox xml]. For the latest 

information on playlist libraries 

that can be displayed by 

rekordbox, see 

the rekordbox online support 

site. 

Auto Export  
Sets whether or not automatic export when exporting music files 

from an external device. 

Database 

Management 

Select master database for use. The master database can be 

transferred to an external device. When the master database is 

transferred, analyzed files are also transferred. By transferring 

master database to an external drive storing music files, you can 

manage tracks on multiple computers. 

Browse 

 
My Tag 

Tick the checkbox “My Tag” to the “Comments”, then my tag is 

added to the Comment column in the track list. 
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Color 

You can edit comments when you classify music files with eight 

color codes on DJ equipment. For more instruction on using Library 

Browse function of DJ equipment, see the Operating 

Instructions for each DJ equipment. 

KUVO 
Tick the checkbox to make the track information public on KUVO 

when importing music files. 

View 

Tick the checkbox to cache track lists. Untick if the memory of your 

computer is insufficient. When you untick it, the speed to display 

iTunes library will improve when you select the track list at Tree 

View. 

Others 

Computer 

name 

Sets the name of this computer to be displayed on the DJ 

equipment (e.g.CDJ-2000nexus or XDJ-AERO). 

Sending 

information 

Sets Agree/Disagree to send information to improve the quality and 

usability of Pioneer DJ products.   

Quantize 

Value 

Select the value to set how precisely quantize the beat.   

 Settings of [CDJ & Device] (Category/Sort/Column) and [Advanced] (Browse > Color) are 

applied to multiple DJ equipment shown on the link status panel. 

 Settings of [CDJ & Device] (Category/Sort/Column) and [Advanced] (Browse > Color) are 

also applied to the default value in [CDJ & Device]. You can change the setting by each USB 

device. 

 

 

 

Preferences: License 

 

This is for activation of added application to rekordbox or purchase license. 

Up to two computers can be activated with one license. 

You can also deactivate it after activation. 

See 2.5 Using PERFORMANCE mode 
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4.14 Menu list 

 

[File] Menu 

Import >Import Track Adds music files to Collection. 

Import >Import Folder Specify a folder and adds music files contained in it to Collection. 

Import >Import Playlist Imports playlist files (M3U and M3U8) as rekordbox playlists.  

Display All Missing Files 
Displays music files in Collection that cannot be played because the 

music file has been deleted, moved, etc. 

Library >Backup Library 

Backs up rekordbox library (database such as Collections, Playlists, 

etc.), analysis information and music files. 

The backup data can be saved with the date added to the file name. 

Library >Restore Library 

Restores the rekordbox library (database such as Collections, 

Playlists, etc.), analysis information and music files. 

Backup library can be transferred to another computer and restored.  

Export Collection in xml 

format 

Exports the information for all the playlists in the rekordbox library 

(database such as Collections, playlists, etc.) and the information 

for the music files in these playlists to a single file in xml format. 

Preferences Changes various settings in rekordbox. 

Exit Exits rekordbox. 
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[View] Menu 

Full screen Displays the rekordbox window at full-screen size. 

1 Player Displays a single player in the Player panel. 

2 Players Displays two players in the Player panel. 

Simple Player 

Displays a simplified version of the player panel. 

Only playback and pause and the volume adjustment operations of the 

music file can be performed. 

Full Browser 
Turns the display of the player panel off. 

Music files are played when they are double-clicked on the browser panel. 

My Tag 

Configuration 

Window 

Displays My Tag Configuration window to the right of track lists. 

Related Track 

List Window 

Displays list of related tracks of a selected music file in an additional 

window to the right side of the track list. 

Information 

Window 

Displays information on a selected music file to the right side of the track 

list. 

Sub Browser 

Window 

Displays another window for Tree View and track lists added to the right of 

the track list.    

 

[Track] menu 

Analyze Track 
Analyzes a selected track to show a full waveform, a zoom waveform, BPM, 

beat positions, and bar positions. 

Analyze Key Detects the key of a selected track. 

Analysis Lock 
Selects On/Off for re-analysis and re-detection of the key of a selected 

track.  

Auto Analysis Selects On/Off for auto analysis for imported tracks. 

Reload Tag 

Reads value of the ID3 tag from a selected track and adds it to the track 

information of rekordbox library (database such as Collections, Playlists, 

etc.). 

Add To Playlist Adds a selected track to a playlist. 
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Import To 

Collection 
Analyzes and adds a selected track to the Collection. 

Export Track Exports selected tracks to a device. 

Remove from 

Collection 

Removes a selected track from the Collection. 

 The music file in your computer is not deleted. 

Show 

Information 
Opens [Information] and displays information of a selected track. 

Show in 

Explorer 
Show a folder in which a selected track is stored in Finder or Explorer. 

Relocate Relocates the file path of a music file. 
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[Playlist] menu 

Export Playlist Exports selected playlist(s) to a device. 

Import Playlist 
Imports selected playlist(s) in [iTunes] or [rekordbox xml] 

to rekordbox. 

Create New Playlist 
Adds a new playlist in the same hierarchy of a selected playlist or a 

folder. 

Create New Intelligent 

Playlist 

Adds a new intelligent playlist in the same hierarchy of a selected 

playlist or a folder. 

Create New Folder 
Adds a new folder in the same hierarchy of a selected playlist or a 

folder. 

Delete Playlist Deletes a selected playlist or intelligent playlist. 

Sort Items 

Sorts playlists in a selected folder in ascending order. 

 [Playlists], [H. Cue Bank], [Playlists] and [H. Cue Bank] in 

[Devices] can be sorted. 

Renumber Track Order Renumbers tracks as sorted in a playlist. 

Save Playlist Info Save information of a selected playlist in text or M3U8 format. 

 

[KUVO] menu 

About KUVO Displays website links about KUVO.com and how to use KUVO 

Edit profile Displays KUVO profile site. 

Tutorial Video Jump to Tutorial Video 

Privacy Settings 
Displays your account made public in KUVO. 

You can make your track information public or private for all the tracks in Collection.  

 

[Help] Menu 

User’s Manual Opens the Operating Instructions for this software. 

Online support Connects to the online support site for this software. 

rekordbox Update 

Manager 
Connects to this software’s update site. 
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Activate Displays purchase of license key and activation window. 

About rekordbox Displays the version of this software. 
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4.15 Managing music files 

4.15.1 Saving data using the backup function 

Regular back-up is recommended to prevent data from being lost due to computer failure or other 

potential disasters. 

Data in rekordbox such as Collection, playlists, analysis data and music files can be backed up. 

The backup function can also be used for migrating data from the current computer to a new one 

before replacing your computer with a new one. Data backed up for Mac can be restored in 

Windows and vice versa.  

 When you install rekordbox in a new computer and use PERFORMANCE mode, 

activation is required for the new computer. See chapter of 2.5.2 Activation for details. 

 

1 Click [File] menu > [Library] > [Backup Library]. 

A caution for backup appears. 

Backing up many tracks stored in [Collection] may take long depending on your computer’s 

performance. 

2 Click [Yes]. 

The dialog [Do you wish to back up music files as well?] appears. 

3 Click [Yes] or [No]. 

Backing up your music files is recommended when you migrate data in the current computer 

to a new one even though it may take time. Music files will be backed up in “rekordbox bak” 

folder to be created at the same place as specified backed up files. 

A dialog box is shown to select where to save the backup data. 

4 Select a place where you wish to store the backup data and click [Save]. 

The backup process begins. Once the process is completed, [Collection was backed up.] is 

shown. Then, press [OK]. 
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4.15.2 Replacing data with the backup data using the Restore function 

Your data is replaced with the backed up data. 

1 Click on the [File] menu and select [Library] > [Restore Library]. 

Restoring many tracks stored in the backup data may take long depending on your computer’s 

performance. 

2 Click [Yes]. 

A dialog box is shown to select a backup data. 

3 Select a stored backup data (***.zip or xxx.edb) and click [Open]. 

The process of replacing the present data with the backup data begins. Once the process is 

completed, [Collection was restored.] is shown. Then, press [OK]. 

You can replace the present data with the backup data in .edb files of the old 

rekordbox versions, too. 

If you restore together with music files, music files created at the same place as the backed up data 

(in “rekordbox bak” folder) is necessary.  

 

4.15.3 Updating the file paths of missing music files 

rekordbox manages information on where music files are stored (file paths). If file and folder 

names are changed or if files or folders are moved or deleted, it may no longer be possible to play 

the music file. (  is displayed to the left of missing music files.) 

1 From the [File] menu, select [Display All Missing Files]. 

The [Missing File Manager] screen opens and a list of missing music files is displayed. 

2 Select the music file whose file path you wish to correct, then click [Relocate]. 

The [Choose a new full path for] screen opens. 

3 Select the folder in which the music file is stored and the file name, then click 

[Open]. 

 The information on where the music file is stored (file path) is corrected. 

 File paths can also be corrected by right-clicking on a music file for which  is displayed 

on [Collection] then selecting [Relocate]. 
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 You can select more than one music files to correct file path. In this case, after the first 

music file is relocated, the rest will follow the same path to be relocated. 

At the [Choose a new full path for] screen, be careful not to select the wrong music file. 
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5 PERFORMANCE mode 

5.1 Enjoy DJ performance with DJ equipment 

You can use rekordbox with DJ equipment by (DJ controllers and CDJ/XDJ) by plugging it with 

your computer via USB cable. 

For equipment supporting rekordbox, check our website: http://rekordbox.com/ 

For more information, see each Operating Instruction of DJ equipment.  

When CDJ/XDJ is connected via LAN using PRO DJ LINK, use EXPORT mode. 

See “4.12 DJ performance on DJ equipment connected to LAN” in “Export mode” in this 

manual for details. .  

You may be unable to properly operate the device depending on USB connection status. 

This could be due to band width of USB port and USB hub on your computer. Changing 

USB hub or port could solve the problem. 

5.1.1 Using rekordbox with a controller 

 Standard settings with a controller 

 

Set preferences according to “rekordbox Setup Guide” to the controller you wish to connect 

with. 

For operation instructions, see Operating Instructions or “rekordbox Function Type Support List” 

at the Pioneer DJ support website（http://www.pioneerdj.com/）. 
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 Controlling four decks by adding CDJs to a controller 

 

 

5.1.2 Using rekordbox with CDJ/XDJ 

 Operate rekordbox with CDJs 

 A DJ mixer is required to be connected with CDJ via audio cables.  
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For connection and operation instructions for each DJ unit, see “rekordbox Connection Guide” 

at the Pioneer DJ support site (http://www.pioneerdj.com/ja-jp/support). 

 

 Example of connection of a computer, 4 CDJs and a DJM 

 Using Pioneer DJ’s DJM series DJ mixer, computer can directly put audio out to the 

DJM, so you do not have to connect CDJs/XDJs and DJM via audio cables. 

 

 

 

 

5.2 Part names and functions 
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5.2.1 Global section 

 

 

Menu to switch application mode 

 

Select EXPORT/PERFORMANCE mode. (If not activated, this drop-down menu does not 

appear.) 

Panel selection button 

 

Click each button to display/hide panels for FX, CFX, sampler, mixer and recording.  

Deck layout menu 

 

Select Deck layout (2deck/4deck, horizontal/vertical or browse screen). 

MASTER LEVEL 

 

Adjust output volume level from MASTER OUT of this application.  

 Preferences button 

 

Click to open [Preferences]. 

Time and audio dropout meter 

 

Displays current time and audio dropout meter. 

Audio will dropout if it reaches to 100%. 

 

Battery meter 

 

Indicates remaining battery life. (It is shown only when the computer is unplugged). 



135 

 

 

 Split Screen 

 

Split screen button (the right bottom of the screen) 

 

Open another window to display browser panel. 

Switch active window 

 

This icon is only appears when you use split screen function. 

Load button (for split screen) 

 

To load a track to a deck:  

1) Select a track. Then click the DECK button. 

2) Drag & drop a track to the DECK button. 

 

5.2.2 Enlarged waveform 

Display (2Deck horizontal) 
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Beat count 

 

 

Indicates the number of bars or beats from the start to currently playing position or from 

the current position to the nearest cue point. You can select [Current Position] or [Count 

to the next Memory Cue] at [Preferences] > [View]. 

Loop section 

 

During a loop, the loop section is displayed (highlighted) on the enlarged waveform. 

Memory cues/hot cues 

 

When memory cues and hot cues are stored, the cues are displayed as marks.  

Zoom in/out of waveform 

  

 

Hover the mouse over the left edge of the enlarged waveform. The buttons to zoom in/out 

or reset the size of the waveform are shown. 
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5.2.3  Functions assigned to Deck section 

 

 

 Around JOG 

 

Selection of loop mode  

   

Click the  to the right of the beat size display of the [LOOP] section (above the CUE 

button) to select auto/manual loop. 

Loop setting (auto loop) 

 

Click the  button to select the length of the loop. Click the beat size display to 

enable/disable the loop. 
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BPM 

 

Displays current BPM of the track. 

Playing speed 

 

Playing speed changes according to the Tempo slider.  

SLIP button 

 

Click this to toggle slip mode. 

Slip mode enables scratching and other performances without breaking the rhythm of the 

track. 

QUANTIZE button  

 

Click this to toggle quantize mode.  

Quantize enables cue and loop position automatically adjusted exactly to the beat 

position. 

 MASTER TEMPO button 

 

MASTER TEMPO On/Off button (toggle this to enable/disable to adjust playback speed 

without changing pitch) 

TEMPO slider 

 

Adjusts track playback speed. 

 

CUE button 

 

Click the CUE button during pause, then a cue point is set to the current position. Long-

click the CUE button, then the playback continues while the button is clicked. If you click 
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the Cue button while playing, the playback stops and the playback position returns to the 

position of the cue point. 

Play button 

 

Click this button to play/pause. 

 Track Information part 

 

Selection of Pad Mode/ Memory Cue/GRID 

 

Click the deck number to select PAD MODE/ Memory Cue/GRID edit from the menu.  

 

Artwork image 

 

Artwork image is shown here. You can unload the track if you click the artwork image. 

Track name/Artist  

 

Displays track name/artist name 

Key  

 

Displays the key of the track. You need to select the [Analyze key] in the drop-down menu 

of the track beforehand.  
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Elapsed time / Remaining time 

 

Click the time to toggle the way of time display (elapsed time/remaining time). 

TEMPO RANGE (Playing speed adjustment range) 

 

Displays adjustment range for playing speed. Click this display to change the range. 

Full waveform 

 

Displays full waveform, cue points, memory cues and hot cues. Click the waveform and 

the current playback position moves to the clicked position. You can change the color of 

the waveform at [Preferences] as you like.  

SYNC button 

 

Activates SYNC function.  

MASTER button 

 

Click to set the deck as the master for the Beat Sync function. 

5.2.4 Performance pad 

 

Switching the mode, you can perform various functions here. 

HOT CUE mode 

Click this and the pads are in the HOT CUE mode. 

PAD FX mode 

Click this and the pads are in the PAD FX mode. 
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SLICER mode 

Click this and the pads are in the SLICER mode. 

BEAT JUMP mode 

Click this and the pads are in the BEAT JUMP mode. 

Pad menu display/hide button (only appears for 4DECK Horizontal layout) 

 

Display/Hide the buttons for each PAD mode. 

 

5.2.5 HOT CUE mode 

 

When hot cues are stored, they can be played instantaneously and marked on full/ enlarged 

waveform. 

PAD button 

Click a pad where a hot cue is not stored, then a hot cue is set at the current playing 

position. Click a pad where a hot cue is stored, the playback jumps to the hot cue point.  

You can set color and comment to hot cues from the drop-down menu (right-click menu) 

of the pad where a hot cue is stored.  

Delete button 

 

Use the button to delete hot cues. 

Memory Cue Call button 

 

Calls memory cues. 
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5.2.6 PAD FX mode 

 

PAD button 

 

 

While pressing the button, the assigned FX is applied. You can change the operation 

style (release FX turns on/off every time the pad is pressed) only for release FX button.  

Switch Banks 

 

You can store number of PAD FXs to switch the banks. 

EDIT button 

 

 

You can change FXs and FX parameters assigned to each performance pads. In the 

parameters, L/D stands for LEVEL/DEPTH as it means in DJM series.  

[Hold] of release FX is to switch the operation style: 1) FX turns on when pressed and 

turns off when released or 2) FX turns on/off every time the pad is pressed.  

BEAT button 

 

Click this button while pressing the pad, and you can temporally change beat of the FX. 
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5.2.7 SLICER mode 

 

PAD button 

As long as the pad is being pressed, Roll playback of a sliced and assigned section 

occurs. (Playback of the section is repeated only when the pad is being pressed.)   

SHIFT button 

 

The range of the slicer is moved using [shift]. 

Slicer loop button 

 

Click to enable slicer playback of the same section.   

LENGTH button 

 

Change the slicer length. 

ROLL button 

Change the length of the roll. 

5.2.8 BEAT JUMP 
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PAD button 

Click to move playback position 

Page switching button 

Use it when you wish to jump to 

5.2.9 Memory CUE 

 

Memory button 

 

Save cues or loops. 

Memory Cue display 

 

Click time display to enter comments. 

Click the left of the time display, or right-click the pane to show the menu for change of 

the color of cue markers. Select color in the menu as you wish. 

Delete button 

 

Click to delete the respective memory cue. 
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5.2.10 Grid edit 

 

Metronome ON/OFF 

 

To enable/disable metronome 

Metronome volume 

 

Adjust volume of metronome 

Analysis Lock 

 

When this turns on, edit of the grid and analysis of the tracks is disabled. This is to 

prevent mistakenly starting edit of the grid and analysis of the tracks.   

Undo 

 

Click to undo the edit. 

Set (the beatgrid) at current playback position  

 

Sets the first beatgrid at current playback position 

Beatgrid transfer 

   

Transfer beatgrid 1msec/3msec  

Make the distance of beatgrid narrower/ wider 
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Make the distance of beatgrid shorter/ longer by 1msec/3msec 

Double/halve the number of beatgrid 

 

Use this to double/halve the number of beatgrid and BPM 

Cancel adjustment benchmark of beatgrid 

 

Cancel temporally marked benchmark to adjust beatgrid. 
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Set a benchmark to adjust beatgrid 

 

This is to temporally mark a benchmark to adjust beatgrid. You can use it for tracks 

whose BPM is changed in the middle of the track.    

BPM manual input 

 

The distance of beatgrid changes according to the BPM you input.   

TAP 

 

Click several times to the beat, then the BPM is set according to the interval of the clicks. 

 

5.2.11 Mixer 

 

 

TRIM knob 

Adjusts the level of audio input in each channel. 

TRIM/ AutoGain switch button 

Click the blue button next to TRIM , then the button changes to orange and then 

name changes to A.GAIN (AutoGain). 
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EQ/ISO (HI, MID, LOW) knobs 

Adjust the volume of each frequency band.  

Kill switch 

Click the blue button next to EQ/ISOLATOR knob, then the parameter is fixed to the 

minimum. 

Channel level indicator 

Displays the sound of the respective channels before passing through the channel faders.  

Monitor CUE button 

Click [CUE] button of the channel you wish to monitor. 

Channel fader 

Adjusts the level of audio in each channel. The audio comes according to the 

characteristics of the curve selected at [Preferences] > [Controller] > [Crossfader Curve])  

 

Crossfader assign button 

Assign channel output to either the left or right of the crossfader.  

Crossfader 

Output audio assigned by crossfader assign button comes out according to the 

characteristics of the curve selected at [Preferences] > [Controller] > [Crossfader Curve])  

 

 MIXING knob 

Adjusts the monitor volume balance of the sound of channel for which the [CUE] button is 

clicked and the sound of the [MASTER] channel. 

LEVEL knob 

Adjust the volume level of the output from the headphones. 

 

5.2.12 Effector 
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FX assign button 

This is to select the deck you wish to apply the effect. Click S (Sampler) to apply the 

effect to the sampler. Click M (Master) to apply the effect to all the decks. 

Switch FX single-mode/multi-mode  

Use this to switch single-mode/multi-mode.  

FX selection menu 

Use this to switch FX 

DRY/WET level knob 

Adjusts volume balance between the original sound and the sound with effect.   

FX ON/OFF button 

To enable/disable FX. 

Parameter adjustment knob 

Adjusts parameter for each effect. 

FX BPM AUTO button 

Automatically detects BPM. 

BEAT change button 

Changes the number of beats to synchronize effect sounds.  

RELEASE FX selection menu 

Adjusts RELEASE FX.  

RELEASE FX BEAT change button 

Change the number of beats to synchronize release effect sounds. 

RELEASE FX ON/OFF button 

Use this to enable/disable RELEASE FX. 
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5.2.13 Recording 

 

Selection of recording source 

 

Selects an audio source you wish to record.  

Adjustment of recording level 

 

Adjusts the recording level. 

Recording level meter 

 

Displays recording level. 

REC button  

 

Starts/Stops the recording. 

Display for elapsed/remaining time for recording 

 

Displays elapsed/remaining time for continual recording. 

5.2.14 Sampler 
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Sampler playback button 

 

 

Click this to start playback of the sample.  

Shift click to stop playback.  

Sampler bank 

 

Click one of these buttons to switch sampler bank.  

Output Channel selection 

 

Use this to select Channel to playback sample when it is in the external mixer mode.  

Sampler deck Quantize 

 

To enable/disable quantize setting 

Sampler deck SYNC 

 

Apply SYNC to the sampler deck (SYNC is only applied to the slots where [SYNC] is 

enabled in the loop mode).  

Sampler deck MASTER 

 

Set the sampler deck as master in Beat Sync mode. 

Sampler GAIN 

 

Adjust volume of sampler deck. 

Sampler BPM 

 

Adjusts BPM for the playback of sampler. You can change the BPM by clicking the button 

and sliding on it. 
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5.2.15 Sequencer 

 

Sequence REC button 

 

Record sampler sequence. 

Sequence playback button 

 

Play sampler sequence. 

Sequence SAVE button 

 

Save sampler sequence. 

Sequence Slot 

 

Indicates how sequence is saved. Sequence name in white indicates the sequence is 

saved. Gray out sequence name indicates the sequence is not saved. Gray out sequence 

name with red circle indicates the sequence is temporarily recorded. Up to eight 

sequences can be saved. 

Beat Counter 

 

Indicates sequence length and beats. During recording or playback of a sequence, a 

marker that indicates playback position is moving. 

Change sequence length 

 

Change the length of sequence 

Sequence MUTE mode 

 

Mute sampler sequence per sampler slot. 
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Sequence ERASE mode 

 

Erase sampler sequence per sampler slot. 

Switch MUTE/ERASE mode and Metronome 

 

Switch mute/erase mode and metronome. 

 

5.3 Basic operation 

5.3.1 Launching rekordbox 

For Windows 7 

Open Windows [Start] menu > [All programs] > [Pioneer] > [rekordbox 4] > and click [rekordbox] 

icon. 

 

For Windows 8.X 

Click [rekordbox] icon in Apps view.  

 

For Mac OS X 

Open [Applications] folder at Finder and click [rekordbox] icon. 
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5.3.2 Loading tracks 

 

1 Select Collection/Playlist from Tree View in the browser section.  

2 Select a track from a track list or selected playlist palette.  



155 

 

3 Drag & drop the selected track to any of the deck (1-4) you wish to load to. 

4 The track is loaded to the selected deck. 

 

5.3.3 Playback 

 

1 Load a track you wish to play to a deck. (See 5.3.2 Loading tracks) 

2 Click the [(PLAY / PAUSE)] button at the loaded deck. 

Playback of the track starts. 

 

 Pause 

During playback, click the [(PLAY / PAUSE)] button to pause. Click the button again to resume 

the playback.  

 

5.3.4 Adjusting the playing speed (Tempo Control) 

 

Move the Tempo slider upward or downward.  

The tempo increases when you move the slider downward (to the [+] direction) and decreases 

when you move it upward (to the [-] direction). 

The changed rate is indicated on the display. 
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 Adjustment range of the playing speed 

 

Click the [TEMPO RANGE] button next to the master button.  

Click the button to change the playback speed by ([6%] / [10%] / [16%] / wide).  

・ The ratio can be adjusted by 0.02 % at [6%], by 0.04 % at [10%] and [16%] and by 0.05 % 

at [wide]. 

・ When set to [-100%], the playback stops. 

 

 Adjusting playback speed without changing the pitch (Master Tempo) 

 

Click the [MT (MASTER TEMPO)] button. 

The [MT] button lights up. The pitch of the track does not change even when you change the 

playback speed by the Tempo slider.  

The sound quality may differ because the sound is digitally reprocessed.  

5.3.5 Setting current cue point 

 

The current cue point is to temporally memorize playback position and can be set per deck. 

When a new cue point is set, the previously set cue point is canceled and thus not saved.  

 To save the cue point, see 5.3.7 Setting hot cue 

 Headphones cue is to check the sound, and it is a different function from cue point 

function. See 5.3.14. Monitoring of audio for details.    

1 Click the [(PLAY/PAUSE)] button during playback. 

The playback pauses. 
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2 Click the [CUE] button. 

The point at which playback pauses is set as the cue point.  

The [(PLAY/PAUSE)] button starts blinking and [CUE] button lights up. No audio plays at 

this moment.  

 When [QUANTIZE] is ON, the cue point might be set at a slightly different position 

from the point you manually set. For details, see 5.3.10 Using Quantize function. 

 

 Returning to cue point (Back cue) 

Click the [CUE] button during playback. 

The track returns to the currently set cue point and pauses. 

 

 Checking cue point (Cue point sampler) 

1 Return to the cue point using Back Cue  

2 Long-click the [CUE] button after returning to the cue point. 

Playback starts at the cue point. While long-clicking the [CUE] button, playback continues.  

If you release the button, the playback position returns to the cue point. 

 

 Setting cue point during playback (Real time cue)  

Click [LOOP IN] at the point you wish to set a cue to set a cue while playing a track.  

 

5.3.6 Setting loop 

You can play repeatedly a specified section by setting a loop. You can start a loop in two ways: 

1) Manual loop – set a start position and end position 

2) Auto beat loop – set a start position and the length of the loop in number of beats.  

 

 When [QUANTIZE] function is on, the loop point is automatically adjusted to exactly 

on the beat. For details, see 5.3.10 Using Quantize function 

 When a supported controller is connected, the loop button is hidden.  
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 Setting Auto Loop 

     

1 Click the ▼ to the right of the [LOOP] button in the Loop display section (above 

the CUE button) to select auto loop or manual loop. (Hover the cursor if ▼ is 

hidden.) 

The drop-down menu opens 

2 Select [AUTO LOOP] mode 

The section switches to [Auto Loop] mode 

  

3 Select the length of Loop (1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 16, 32 beats) using 

the [◀] or [▶] button. 

The display of the beat number changes. 

4 Click the [AUTO BEAT LOOP ON/OFF] button, where the beat number is 

displayed, when you wish to start an auto loop. 

A loop is set and the playback repeats in the specified section. 

5 Click the [AUTO BEAT LOOP ON/OFF] button again to cancel the loop. 

 

 Setting a manual loop 

    

1 Hover the cursor to the right of the [LOOP] button (or the AutoBeat button) in 

the Loop display section (above the CUE button); then, ▼ button shows up. 

Click ▼ button to select auto loop or manual loop. 

The drop-down menu opens.  
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2 Select [MANUAL LOOP] mode. 

 

3 Click the [IN] button at the position you wish to start a loop. 

This sets a starting point. 

 Cue point is set at the same position. 

4 Click the [OUT] button at the position you wish to end the loop (at the position 

you wish to jump back to the starting point of the loop).  

 During loop playback, the [RELOOP] button changes to the [EXIT] button. 

 

5 Click the [EXIT] button to cancel the loop mode. 

6 Click the [RELOOP] button if you wish to call the loop. 

The playback jumps back to the loop position previously set. 

 

5.3.7 Setting hot cues 

Hot cues are used to mark different points in the track from which you wish to start playback. 

Each point can be called out, and the track starts playing instantly from there. You can set up to 

8 cue points per track. 

 Hot cues are also used for various DJ performances 

 

 Saving hot cue 

1 Click the [HOT CUE] mode button. 

The panel is changed to Hot Cue mode. 

2 Move the current playback position to the point you wish to set a hot cue.  

3 Click a performance pad where no hot cue is assigned. 

A hot cue is assigned to the pad you clicked. 
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 When a loop is playing, the loop is assigned and saved as a hot cue. 

 You cannot assign a new hot cue to the pad where another hot cue is already 

assigned. You need to delete the existing hot cue to assign a new one. How to delete 

a hot cue is described below. 

 

 Calling hot cue 

1 Click the [HOT CUE] mode button. 

2 Click any performance pad while the deck is playing a track or on pause.  

The hot cue saved in the pad is called up and playback is started.  

 After calling up the loop assigned to the performance pad button, you can cancel the 

loop playback or change the length of the loop.  

 Deleting hot cues 

1 Click the [HOT CUE] mode button to change the mode. 

2 Click the [x] button in the upper right of the performance pad button of the hot 

cue you wish to delete.  

The hot cue is deleted and the pad button becomes empty.   

 

5.3.8 To use slip mode 

When the slip mode is turned on, even during you perform scratching, looping and hot cue play, 

the track continues to play in the background. When you finish your performance, the track 

resumes to play in the foreground as if the track skips time during which you performed. 

Using this function, various performance can be achieved without breaking the original tempo 

and musical proceedings. 

You can perform the followings in the slip mode:  

1. Hot Cue 

2. Scratch (JOG operation) 

3. Playback/Pause 

4. Loop 

5. Reverse playback (only using a controller) 
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 To enable/disable slip mode 

 

The slip mode can be set per a deck. 

Click  button on the deck to enable the slip mode. The button turns . 

Click  button to disable the slip mode. The button returns to . 

 

 Slip hot cue 

When the slip mode is on, hot cues behave as follows: 

1 While clicking a performance pad, playback starts from the saved hot cue point. 

(This is the same behavior when slip mode is off). 

2 When the pad is released, the playback resumes from the last point the track 

was playing at in the background.    

 

 Slip scratch (JOG operation) 

When the slip mode is on, scratch playing behaves as follows: 

1 While playback, play scratching using top of the JOG dial of the controller 

Real-time playback continues in the background while scratch-playing.  

2 Release the top of the JOG dial. 

3 The playback resumes from the point the track reached in the background.    
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 Pause and Playback in slip mode 

While the slip mode is on, pause and playback behave as follows:  

1 Click the [PLAY/PAUSE] during playback 

Playback pauses. 

 When pause speed is set at [Preferences] > [Controller] > [Vinyl Speed Adjust], the 

playback pauses slowly.  

2 Click [PLAY/PAUSE] again. 

The playback will resume from the point the track was playing at in the background.   

 

 Slip Auto Loop 

When the slip mode is on, the auto loop behaves as follows: 

1 Call Auto Loop mode 

 

2 Click [◀] or [▶] button to select the length of auto loop. 

3 Click the [AUTO LOOP] button. 

A loop of selected length is set and the loop playback begins. 

4 Click the [AUTO LOOP] button again 

The loop is canceled and the playback resumes from the last position the track was 

playing at in the background. 

 

 Slip Manual Loop 

When the slip mode is on, the manual loop behaves as follows. 

1 Call Manual Loop mode 

2  
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3 To start the loop playback, click the [LOOP IN] button and then the [LOOP OUT] 

button. 

4 To cancel the loop playback, click the [RELOOP LOOP/EXIT] button. 

5 The playback resumes from the position the track was playing in the 

background. 

 

5.3.9 Using Beat Sync function 

When Beat Sync is turned on, BPM and beat positions of tracks playing can automatically be in 

sync with a track playing on the deck or the sampler deck set as sync master.    

Note: Before using Beat Sync function, you need to analyze music files to obtain beatgrid 

information. 

 Setting Sync to a deck 

 

1 Click the [MASTER] button on a deck or a sampler deck you wish to set as sync 

master 

2 Click the [SYNC] button 

The BPM and beat positions of the currently playing tracks are in sync with those of a 

track on the sync master deck. 

 Click the [SYNC] button again during the Beat Sync play to cancel the sync. 

 Setting Sync to a sampler deck 

SYNC can be set not only on the entire sampler deck and but also in each sampler slot. 

To use the SYNC function in a sampler slot, you must turn on SYNC at both on the deck and in 

the slot. In addition, SYNC is only applied to loop-mode sample source. 

 One-Shot mode sample audio source cannot be played in SYNC mode. 

 

1 Click the [SAMPLER] button at global section to display sampler deck. 
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2 Click the [SYNC] button to enable SYNC in the sampler panel.  

3  

4 Click the [EDIT] button of the sampler slot you wish to enable SYNC. 

5  

6 Click the [SYNC] button in the edit display to enable SYNC.   

7  

 Changing deck or sampler you wish to set as sync master 

You can switch sync master deck or sampler as follows: 

 Relocate the track in the sync master deck to another deck. Or set the deck on pause. 

 Click the [MASTER] button on the deck defined as sync master.  

 Click the [MASTER] button of decks or sampler decks except for the one set as sync 

master.  

 

5.3.10 Using Quantize function 

When Quantize is turned on, loop in/out points and hot cues can be automatically adjusted to 

the beat position nearest from the current playback position.  

You can perform hot cues, loops, slip and slicer without breaking the original tempo of the 

playing track. 

Quantize mode can be set independently on decks. 
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 Setting Quantize function 

 

Click the quantize button  on a deck where you wish to turn on the 

Quantize function. 

The button turns  and the Quantize function is turned on. 

 Setting Quantize function to a sampler deck 

 

Click the Quantize button  at a sampler deck 

The button turns  and Quantize function is turned on. 

 

5.3.11 Using Instant Double function   

(Note: This function is only available when a controller is connected.) 

When you call up the Instant Double function on a controller, a track on a deck will be loaded to 

another deck with the status and the state copied over such as a playing position, a loop and its 

state of On /Off, Pad mode, and Slip mode state of On/Off, etc.; then, the track on a deck copied 

to will start playing from the same playing position of the deck copied from. 

 

 How to call up the Instant Double function depends on the controller. See the 

Operation Instructions of each controller. 

 For example, push the load button twice to call up the instant double function. 
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5.3.12 Using beat jump 

You can instantly jump backwards or forwards from current playback position by a pre-

determined number of beats/bars 

 

1 Click the [BEAT JUMP] mode button to turn on the beat jump mode. 

2 Switch the page by clicking the [<] or [>] button to select the beats/bars. 

・The range is as follows: FINE(=1/16 beat), 1/8 beat, 1/4 beat, 1/2 beat,1 beat, 2 beats, 

8 beats, 16 beats, 8 bars, 16bars.  

3 Click any performance pad. 

The current playback position jumps to the designated direction by the selected number 

of beats/bars.  

 

 

5.3.13 Using mixer function 

You can display/hide the mixer panel at by clicking the [MIXER] button at the global section.   

Note: When you connect your computer to a DJ controller, the mixer panel is automatically 

hidden.  

 

 Adjusting audio tone level 

Turn the corresponding [HI], [MID], or [LOW] knob to adjust audio tone of the currently playing 

deck. 
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 To switch [EQ/ISO (HI, MID, LOW) ] function at the knobs 

You can switch [EQ]/ [ISOLATOR] at [Controller] -> [Mixer] -> [EQ] at [Preferences].  

 [EQ]: Equalizer mode 

 [ISOLATOR]: Isolator mode 

 

 

5.3.14 Monitoring of audio 

  

You can monitor audio from headphones with two knobs at the mixer panel: the headphone cue 

button, and the headphone panel. 

 

Set positions of knobs and others as follows: 

1 Set  headphone mix knob at the center. 

The audio from [MASTER OUT] and [HEADPHONE CUE] output will be heard at the 

same volume.  

2 Turn  headphone volume knob fully counterclockwise to mute the sound. 

Initially setting at mute mode, you can adjust the volume with the following steps. 
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3 Click  button of the mixer corresponding to the deck you wish to monitor.  

The button changes to  and you can monitor the audio. 

4 Turn  headphone volume knob to adjust volume. 

The further the knob is turned clockwise, the louder volume becomes. Please adjust the 

volume as you wish.  

 

5.4 Changing graphical user interface (GUI) 

You can change GUI layout according to your DJ style. 

 The number of the decks displayed, horizontal/vertical display of enlarged waveforms 

and size of browsing area can be changed at your choice. 

 You can display/hide mixer, effector, sampler and REC panels. 

 

5.4.1 To change layout 

Click [View] in the menu bar to show drop-down menu items to choose the layout.  

You can choose the number of the decks displayed, horizontal/vertical display of enlarged 

waveforms and the size of the browsing area. 

 

 Choose [2DECK Horizontal] or [2DECK Vertical] when you use two decks.  

 Choose [4DECK Horizontal] or [4DECK Vertical] when you use four decks.  

 For mixing, we recommend the horizontal layout as waveforms are fully displayed.  

 For scratching, we recommend the vertical layout as waveforms are displayed vertically.  

 Choose [Browse] for wider browse screen. It will be easier to select tracks.     

  

5.4.2 To display/hide mixer, effector, sampler and REC panels. 

You can display/hide mixer, effector, sampler and REC panels.  
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5.5 Analysis Lock 

You can disable analysis function to prevent mistakenly analyze a track and edit its grid that was 

already edited. There are two ways to enable analysis lock function.  

 Effect of the analysis lock 

The followings are disabled when you lock analysis. 

 Track analysis 

 Key analysis (detection of key) 

 All grid edit operations  

When a number of tracks are selected on the track list including tracks which are locked 

analysis, the analysis-locked tracks are skipped when they are analyzed.  

 How to set/reset Analysis Lock at grid edit panel 

1 Click the number of a deck in which a track you wish to lock analysis is loaded. 

The following menu is displayed. 

 

2 Click [GRID], and open [Grid Edit Panel] 

The following panel opens. 

 

3 Click the lock icon   

Analysis lock is activated and the icon changes from  to . 
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 To cancel the analysis lock, click . 

 How to set/reset analysis lock from track list 

1 Right-click a track on the track list and click [Analysis lock] > [On] in the drop-

down menu.  

When analysis is locked,  is displayed in the status column. 

2 To cancel the lock, right-click the track and click [Analysis lock] > [Off] in the 

drop-down menu. 

 

5.6 Recording  

You can record your DJ performance in the PERFORMANCE mode. 

The recorded file will be created in a .wav file. 

 To Display/hide REC panel 

The button to start/stop recording is on the REC panel. 

Click the REC button in the global section on the top of the screen to 

display/hide REC panel. 

 

 

 To select recording source 

In rekordbox, various recording sources exist such as output from each deck, virtual DJ mixer 

output in software. You can select a recording source from drop-down menu.  

1 Click drop-down menu. 

Eligible recording sources are shown. 

2 Select the one you wish to record. 

Recording source is changed. 

 To record from the software mixer mode, choose [Master Out]. 
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 Adjustment of recording level 

We recommend you to adjust recording level properly. If the level is too low, the audio volume of 

the recorded file is small and noisy. If the level is too high, clipping occurs and the sound is 

distorted. 

1 Play a track 

The recording level meters light up. 

2 Turn the knob of recording level to adjust. 

 The best recording quality can be obtained by increasing the recording level maximum 

to the level in which not all the meters hitting red. 

 The meters tend to swing widely when effect is applied or in time of mixing.  

  

 To start/pause recording  

1 Press the [Recording] button  to start recording. 

During recording, elapsed time and remaining time for recording is shown. Graphic of the 

[Recording] button  changes. 

 

2 Press the [Recording] button  again to stop the recording. 

 

 Other settings for recording 

You can change a location of storing recorded files at [Preferences]. See the chapter 5.12 

Setting preferences 
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 Display/delete of the recorded file 

 

Click [Recordings] in Tree View to display recorded files in a track list. Choose a recorded file in 

the track list and drag and drop in a deck to playback the recorded file.  

To delete an unnecessary recorded file, select it and enter the [Delete] key.  

 Otherwise, select [Delete] in the drop-down menu (right-click menu).   

 

5.7 Effect (FX) 

There are three effect modes in rekordbox; BEAT FX, SOUND COLOR FX and RELEASE FX. 

PAD FX is equipped for the operations of these effects using the pads. 

Various effects, quite popular ones in our DJ mixer DJM series and remix station RMX series, 

are pre-installed in rekordbox, opening the door to a wide variety of DJ performance.   

See the Operating Instructions of each DJ controller regarding how to control effects using a DJ 

controller. 

 

5.7.1 To display effect panel 

Click [FX] or [CFX] button in the global section to display/hide the effect panel.  
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 Open [FX] panel 

Click the [FX] panel button . 

The [FX] panel button lights up and [BEAT FX] and [RELEASE FX] are displayed. 

 

 Open [CFX] panel 

Click the [CFX] panel button . 

The [CFX] panel button lights up and [SOUND COLOR FX] is displayed.  

 

 Open [FX+CFX] panel 

Click the [FX] panel button  and [CFX] panel button . 

The [FX] panel button and the [CFX] panel button light up and all of [BEAT FX], [RELEASE FX] 

and [SOUND COLOR FX] are displayed. 

 

 

 

5.7.2 To select decks to apply effect 

Select decks to apply FXs (BEAT FX and RELEASE FX) to for each effect unit.  
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 Apply effect to deck 1 to 4 

Click any of the effect assign buttons     . 

The clicked button lights up and FX is applied to the deck. 

 Click it again to cancel the assignment. 

 

 Apply FX to sampler deck 

Click . 

The [S] button lights up and FX is applied to the sampler deck.   

 Click again to cancel the assignment. 

  

 Assign FX to master out 

Click . 

The [M] button lights up and FX is applied to the master out. 

 Click it again to cancel the assignment. 

 If you assign FX to the master out, you cannot assign that FX to any other decks or 

the sampler deck.  

 If you assign FX to the master out even when deck 1 to 4 and sampler decks are 

already assigned, the assignment to deck 1 to 4 and sampler deck are disabled. 

 

5.7.3 BEAT FX 

Using BEAT FX, you can use various effects matching to tempo (BPM) of a track loaded to the 

deck. Furthermore, you can control two effect units, FX1 and FX2, allowing you to assign a deck 

for each unit freely.   

BEAT FX has two effect modes: single-mode and multi-mode. 
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5.7.4 To change effect mode 

 Set BEAT FX to multi-mode 

Click  button. 

The mode is switched to multi-mode. 

 

 Set BEAT FX to single-mode 

Click  button. 

The mode is switched to single-mode. 

 

 

 Use BEAT FX in multi-mode 

 

Up to three effects can be used simultaneously per effect unit.  

Each effect unit is equipped with [LEVEL/DEPTH] knob and [Effect ON] button. 

 

1 Select a deck to assign effect 

See 5.7.2 To select decks to apply effect. 

2 Click FX drop-down menu  to select the effect. 

3 Open drop-down menu to select the effect. 

4 Click the [FX ON] button . 

The [FX ON] lights up and FX turns on.  
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5 Turn the [LEVEL/DEPTH] knob . 

This adjusts the balance of the original sound and the sound with effect.  

 

6 Click the [Beat] button  . 

Apply effects in sync with BPM. 

 Some of the effects, including REVERB, value of the parameter is set instead of 

beats.  

 When you select both of effects set by beats and ones set by parameter value are 

selected, and these effects turn on at the same time, both of the beats and parameter 

value are displayed.  

 

 Use BEAT FX in single-mode 

 

One effect can be selected per effect unit. Up to 3 parameter knobs and up to 2 parameter 

buttons are available.  

 

1 Select deck to assign an effect 

See 5.7.2 

2 Select effect to click the FX drop-down menu . 

3 Open the drop-down menu to select an effect. 

4 Click the [FX] button . 

[FX ON] lights up and FX turns on.  

5 Turn the [LEVEL/DEPTH] knob . 

It adjusts the balance between the original sound and the sound with effect. For example, use 

the knob to coordinate how much echo is mixed to the original track.  

 Only the original sound comes out when the knob is turned fully counterclockwise. 
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 Only the sound with effect comes out when the knob is turned fully clockwise.   

 

6 Turn the parameter knob  and . 

They adjust level of the effects. 

 Parameter differs depending on each effect. 

 

7 Click the parameter button  and . 

The [Parameter] buttons light up and the setting is activated, and level of the effect changes. 

 Parameter differs depending on each effect. 

 

8 Click the [Beat] button . 

Apply the effect in sync with BPM.  

 Some of the effects, including REVERB, parameter value is set instead of beat. 

 

 Save parameters 

Click effect unit number (FX1/FX2) and click [Save Snapshot] in the menu. 

   

You can save several parameter settings you already adjusted (position of parameter 

knobs and parameter buttons). 

 Once adjusted settings are saved, you can call the saved parameter(s) the next time 

you select the effect again. 

 

 Position of the [LEVEL/DEPTH] knob is not saved.  

 This function is only available for single-mode. 
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 Setting of BPM 

You can set the BPM of effects. There are two modes, AUTO mode and TAP mode, for the 

setting of BPM.  

 AUTO mode is set by default.  

 

 AUTO mode 

 

The BPM of a track loaded to a deck is the benchmark BPM for the effect. You can apply effect 

in sync with the BPM of the track per deck. 

 

 TAP mode 

 

When  button is clicked several times in rhythm, the BPM is set as the base value for the 

FXs according to the interval of the clicks. Select AUTO mode and TAP mode 

 

 Switch AUTO/TAP mode 

Click “BPM” on the computer screen and select the mode from the drop-down 

menu. 
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5.7.5 RELEASE FX 

RELEASE FX is a function to apply effects while canceling BEAT FX, enabling smooth transition 

of the current playing track and the effect sound. You can also change settings to turn off 

SOUND COLOR FX. 

 

 How to use RELEASE FX 

1 Click the FX drop-down menu  to select an effect. 

Open the drop-down menu and select an effect. 

2 Click the beat button   

Set the length of the RELEASE FX you wish to add. 

3 Long-press the FX [ON] button  

The FX [ON] button lights up and the effect is applied to the track.   

This turns BEAT FX off in the same effect unit.   

4 Release the FX [ON] button  

The light of the FX [ON] button turns off and the sound returns to the original sound.  

 

5.7.6 SOUND COLOR FX 

 SOUND COLOR FX is an effect whose level is changed according to its COLOR knob. 

Selecting a type of the effect and turn the knobs, then you can easily arrange tracks in a 

wide variety of styles.  
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 How to use SOUND COLOR FX 

1 Click the CFX button  to select an effect. 

2 Open drop-down menu to select effect 

Selected effect automatically turns on.  

 The same effect is applied to Channel 1 to Channel 4. 

 To cancel the effect, click the name . 

 

3 Turn COLOR knob 

The effect is applied to the music of the channel you turned the knob. 

 When COLOR knob is set at the center, the effect is not applied. 

 The effect differs when you turn the knob clockwise and counterclockwise. 

 

 Turn off both RELEASE FX and COLOR FX 

Open [Preferences] > [Controller] > [Effector] > [Release FX] and tick [Apply Release FX on 

CFX]. Then you can turn off RELEASE FX and SOUND COLOR FX at the same time. 

 The channel to be turned off is the channel you set at an effect assign button.   

 

 

5.7.7 PAD FX 

PAD FX enables a wide range of effect performance just by pressing and releasing the [PAD] 

button. 

 

 Display PAD FX 

1 Click the PAD FX button on the deck section. 

Preset FXs for each PAD button are displayed. 

 



181 

 

 

2 Click button  to switch the page. 

PAD FX has two pages, and a different preset can be set to each page. 

 

 Click the button  to go back to the page 1. 

 

 How to use PAD FX (mouse operation) 

1 Keep pressing the mouse at the [PAD FX] button 

Once the [PAD FX] button is long-pressed, the PAD page lights up and the effect turns on.   

2 Release the mouse from the [PAD] button 

The light of the PAD button and the effect turns off. 

 

 When using a mouse, you can control only a part of the operations.  

 How to use PAD FX (operations with a controller) 

1 Keep pressing a performance pad 

While pressing the performance pad, it lights up and the effect turns on.   

2 Release the performance pad from your fingertips 

The light of the performance pad turns off and the effect is cleared. 

 

 When you press more than one performance pads (different FXs), all the FXs turn on. 

 If the same FX has different beat sizes, only the last performance pad you pressed 

turns on. 

 

 How to use RELEASE FX in PAD FX (operation with a controller) 

1 Keep pressing performance pads except RELEASE FX. 

While pressing the performance pads, they lights up and the effects turn on. 

2 Press the performance pad at which the RELEASE FX was set. 



182 

 

The RELEASE FX effect turns on. 

 Other effects in PAD FX turn off. 

3 Release all the performance pads from your fingertips 

The light of all the performance pads turns off and the sound returns to the original sound. 

 How to change beats temporally at PAD FX (operation with a controller) 

You can temporally change the beat size while pressing a performance pad.   

1 Keep pressing the performance pad at which FX in sync with beats was set 

While pressing the performance pad, the pad lights up and the FX turns on. 

 

2 Press the [PARAMETER1←] button or the [PARAMETER1→] button while 

pressing the performance pad. 

The beat size changes according to the button.  

 Edit mode 

Edit mode allows you to customize types, the beat size and parameters. 

 Customize PAD FX 

In the edit mode, customize of PAD FX is allowed under these restrictions listed below: 

 The four pads in the upper part of the PAD FX are only used for single FX. (You cannot 

assign different types of FXs) 

 Only the beat size can be customized at the upper part of the PAD FX. 

 The far right pad in the lower part of PAD FX is for the RELEASE FX. 
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1 Click the [EDIT] button  

The edit mode panel opens. 

 Click the button again to exit the edit mode. 

 

2 Click the effect you wish to customize from the effect drop-down menu

. 

3 Open the drop-down menu and select the effect. 

4 Click the parameter drop-down menu . 

5 Open the drop-down menu to select the beat size and values of parameters.  

 You can directly input parameter values in from the keyboard of your computer. 

 In the RELEASE FX pad, you can set HOLD on/off. 

  

・ON You can turn FX on/off by pressing the performance pad. 

・OFF FX turns on while pressing the performance pad and turns off when the mouse is 

released.  

 

5.8 Sampler 

rekordbox sampler deck has 16 sampler slots (or simply, “slots”).  

You can use the sampler in various ways, from the basic One-Shot mode to SYNC mode with a 

track on the deck. You can extract a section of a track on the deck and load it to a sampler slot 

by our CAPTURE function. For CAPTURE function, see 5.11 CAPTURE. 

 

5.8.1 To display sampler deck 

 Open SAMPLER panel 

Click the SAMPLER panel button  in the global section. 

The button lights up and the sampler deck is displayed.  
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5.8.2 To use sampler 

 Load sample audio to a sampler slot 

1 Drag and drop a track from a track list and load to a sampler slot 

Waveform and the title of the track are displayed. The play mode is set to One-Shot 

mode. 

 

 The loaded track is stored even after you exit the application.  

 When you put a mouse curser to the title of the track, the eject button is shown. Click 

the [Eject] button  to unload the track. 

 

2 Click the BANK button  

The bank of the sampler deck is switched. The sampler deck has four banks, each of 

which has 16 slots.  

 Playback of the sampler slot 

Click the [Play] button in the sampler slot  (or ). 

The [Play] button in the sampler slot lights up and playback is starts.. 

 

 Click the [Play] button in the sampler slot while pressing the [Shift] key, then layback 

pauses.  

 [MUTE] button appears when you put mouse curser at the title of the track in the 

sampler slot. Click the MUTE  button to mute the sound.  

  

In the mute mode, the mute button lights up and the [Play] button turns in white.  
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 Change preferences of the sampler slot (Edit mode) 

You can change the Play mode and adjust volume per sampler slot. 

Each setting status is saved per sample material. 

 

Click the [EDIT] button . 

The edit button lights up and the edit subpanel opens. 

 

 Edit subpanel is displayed next to the sampler slot. 

 

 Change the Play mode 

Click the One-Shot mode button  or the Loop mode button .  

The [Play] button in the slot is changed 

 One-Shot 

Click the button to continue playback till the end of the track and then pauses.  

Click the [Play] button during playback to restart playback from the beginning of the track. 

 

 Loop 

Click the button to start the loop playback. 

 Click the [Slot Playback] button while playing, and the loop playback will start from the 

beginning. 

 

 The Play mode (One-Shot/Loop) can be changed from the drop-down menu in the 

track list. 

 For tracks in the sampler slot in [One-Shot]/[Loop] mode, the status icon is shown at 

the far left of the track list.  
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 GATE mode 

Click the GATE mode button  in EDIT mode. 

The GATE mode button lights up and the GATE mode is applied.  

 When the GATE mode is applied, playback continues only when you keep pressing 

the [Play] button in the slot. When the [Play] button is released, the playback pauses.  

 When you click GATE mode button again, GATE mode turns off. 

 Master tempo 

Click the master tempo button  in the edit subpanel. 

The master tempo button lights up and the master tempo function is applied. 

 Once the master tempo function is on, loop playback will start without altering pitch of 

sound even when the track is played in a tempo different from the original tempo 

(BPM).   

 When you click the master tempo button again, the master tempo function turns off. 

 Slot SYNC 

Click the SYNC button  in the EDIT subpanel.  

The SYNC button lights up and SYNC function is applied. 

 The SYNC function is applied only to the sampler slots in the Loop Playback mode.    

 Once SYNC is applied to a slot, Loop will start playback in sync with the BPM of the 

sampler deck.   

 When you click the SYNC button again, SYNC function in the sampler slot turns off.  
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 Slot Gain 

Turn Gain knob  in the edit subpanel. 

It controls sound volume of the track loaded in the sampler slot.  

 When the volume varies widely per sampler slot, you can adjust it with this knob to 

level the volume.  

  

  Fine control of playback position 

Click the (Grid Left/Grid Right) button  for fine control of playback 

position in the edit mode. 

 Only a sampler slot set to One-Shot mode can finely control playback position.  

 BPM adjustment 

You can adjust BPM in the edit mode. 

Click  to double the BPM. 

Click  to halve the BPM. 

You can change BPM by clicking the BPM display  and putting a value in. 

 

 Playback of samples in the slot while switching banks 

In rekordbox, switching the banks behaves as follows. 

The sample playback does not stop when you switch the banks. However, when you 

playback a sample in the slot in the same slot position of the previous bank, the playback 

of the sample in the previous bank pauses and the playback of the sample in the 

currently displayed bank starts.  

The followings shows an example of this: 

 

1 Click the [Play] button of the slot  in Bank1  
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Playback of sampler slot  in Bank1 starts. 

 

  

2 Switch BANK1 to Bank2 by clicking the Bank button. 

When a sample in the slot in another Bank is currently played back, the level meter (gray) 

is shown. 

The gray level meter shown in  displays the playback status of the sample in the 

background, i.e., in the sampler slot . 

 

 

3 Click the [Play] button in the slot  in Bank2. 

 

When you playback sample in the slot (Bank2) shown in , the playback of the sample 

(Bank1) shown in  pauses. 

 

 SYNC sampler deck with player deck 

In rekordbox, you can playback samples in the slots set in the Loop Playback mode in sync with 

player deck.   

 The following shows an example of this: 
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1 Check the [SYN ] button of the EDIT sub screen  of the slot  and of the 

sampler deck  light up (activated). 

 

2 Load a track to Deck1 and start playback. 

 Click the [MASTER] button at Deck1. (As an example, BPM of Deck1= 82.25). 

  

3 Click the [Play] button of slot . 

 

When a sample in the slot  is played back, its BPM is set at 82.25. 

And the BPM subpanel of the sampler deck displays the BPM value of the MASTER deck 

for SYNC. 

 

 Click the [MASTER] button in the sampler deck to set it as MASTER. 

 To adjust the BPM of the sampler deck, use  to change the value. Click the 

BPM display  and put the value in to change the BPM. The BPM can be 

changed either it is set as MASTER or the SYNC function is off.   
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 To use Quantize function 

Click  button 

 button lights up and the Quantize function turns on. 

 For beat setting of the Quantize, select from [1/16, 1/8, 1/4, 1/2 and 1] at [Preferences] 

> [Controller] > [Other] 

 The Quantize function is only enabled in sampler slots in the Loop Playback mode.  

 

 To adjust the volume of the sampler deck 

 

1 Click the [SAMPLER] panel button  in the global section and the 

[MIXER] panel button  

Both of the button light up, and sampler deck and mixer panel show up. 

 The sampler volume slider and the sampler monitor CUE are shown only when both of 

the [SAMPLER] panel and the [MIXER] panel are open. 

 

 

2 Turn the GAIN knob  at the sampler deck 

It adjusts the volume of the entire sampler deck. 

 When mixing, the volume level can be adjusted using the GAIN knob if the volume of 

the sampler deck and other decks differ. 

3 Move the VOLUME slider  in the sampler deck. 
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It adjusts the output level of the entire sampler deck. 

 When you check the volume level before outputting the sound out to the [master out], 

set the sampler volume to the minimum, click the sampler monitor CUE button  

to activate it and then check the volume level with headphones. 

 

5.8.3 Color setting of sampler slots 

You can customize colors of the buttons for tracks loaded to each sampler slot.  

Change the color setting of sampler slots as follows: 

1 Change Preferences 

・Open [Preferences] > [View] > [Color] > [Sampler] and tick [Sync with Frequency]. 

 

 [Fixed] is set by default. 

  [Sync with Frequency] - Color of the buttons changes in sync with frequency. 

           You can customize color of the buttons.  

 [Fixed] - Set by default and cannot be customized. 

2 Right-click and select color from the drop-down menu of the [Slot playback] 

button 

 

5.9 Sequencer 

rekordbox has a sequencer function, allowing you to record, playback and store the sequences 

you played at the sampler deck. Enjoy various DJ performance with this sequencer. You can 

create original rhythm loop or vocal loop that are prepared in advance for the track you are 

playing, use overdubbing function to add samplers such as improvised finger drums, or use 

mute function to arrange the track by removing particular sounds.      
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5.9.1 How to use sequencer 

 Record the sequence 

1 Click the BPM display in the sampler deck, and input the value to set the BPM 

 

2 Select the bank of the sampler slot you wish to play  

The selected bank shows up. 

3 Select the length of sequence recording 

Click [1Bar] to select the length from the drop-down menu (1Bar, 2Bar or 4Bar).  

 

The length of the sequence recording is fixed. 

 

4 Click the [REC] button  

The REC button starts blinking and sequence recording turns in the stand-by mode.  

5 Click the [Play] button of the slot  at the sampler deck. 

Recording of the sequence begins at the moment of the clicking.   

 During overdub recording, the sequence of the playback is temporally recorded.  

 Temporally recorded sequence is shown with a red circle in the sequence slot.  

 

 

 Recording of the sequence is only possible for sampler slots in One-Shot mode.  

 Once [QUANTIZE] at the sampler deck is activated, quantized sequence is recorded 

and played back.    
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 You can also record the sequence by clicking the [Play] button of the sequence in the 

stand-by mode.  

 Temporally recorded sequence will be deleted when you restart recording without 

saving it or when you exit the application without saving it.   

6 Click [SAVE] button  

The sequence is saved. 

The name of the saved sequence is highlighted in the sequence slot.  

 

 Up to eight sequences can be saved. 

 Call saved sequence for playback 

1 Click  button or  button to select the sequence  

Selected sequence is in stand-by mode. 

 

2 Click the [Play] button  

 

Sampler slot is automatically played back according to the saved sequence. 

 

 The bank is automatically switches to the bank of the sampler slot of the saved 

sequence.   

 Click the [Play] button again to stop the sequence. 

 Click the [Rec] button during the playback of the sequence to enable further 

overdubbing.  

 The bank cannot be switched while playing back/recording of the sequence. 

 If you call a sequence, sampler slots which had been playing before calling will pause. 

 

 Delete saved sequence 

Click the [Delete] button  to delete the sequence. 

 

When a sequence is deleted, the sequence name is grayed out. 
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 Sequence Mute mode (operation using a controller) 

Sequence Mute mode is a mode aimed to control to enable/disable the mute function 

using a pad on the controller. During the playback of a sequence or overdubbing, you can 

enable/disable mute per sampler slot. 

You can arrange the rhythm loop you made with the sequencer by eliminating/adding 

particular sounds per sound source, such as kick and snare, for DJ performance.   

 

1 Call out and play a sequence 

2 Press the [MUTE] button 

Sequence the [MUTE] button  lights up and the sequence mute mode turns on. 

 

 In the sequence [mute] mode, sampler slots of the recorded in the sequence is 

displayed [Active]. 

 When pressing the [PARAMETER(←)] button while pressing [shift] button, sequence 

MUTE mode turns off.. 

3 Press a performance pad to which you wish to apply mute. 

Mute is applied to the pressed performance pad. 

 

 Press the pad again to cancel mute. 

 

 Sequence Erase mode (operation using a controller) 

In the sequence Erase mode, you can erase sequence on a sampler slot basis during the 

playback of a sequence or overdubbing. 

While the sequence erase mode can be operated from your computer, the following 

instruction is for the operation using a controller.   
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1 Call out and play a sequence 

2 Press the [PARAMETER(→)] button while pressing [shift] button 

3 Sequence Erase button  lights up and the Sequence Erase mode turns on. 

 

 In the sequence erase mode, sampler slots of the recorded sequence are displayed. 

 When pressing the [PARAMETER(←)] button while pressing [shift] button, sequence 

Erase mode turns off. 

  

 

4 Press the performance pad where the sequence you wish to erase is assigned 

 The sequence is erased and the sampler slot is displayed as non-active.  

 

 

 Metronome 

1 Switch to metronome display 

1. Click the [MODE] button next to the [MUTE] button and select 

[Metronome] from the drop-down menu.  

 

 

The MUTE and ERASE buttons are switched to Metronome display. 

 

2. Click the [Metronome] button  

The [Metronome] button lights up and the sound starts. 
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3. Click the [Metronome Volume] button  to change the volume 

The metronome volume can be adjusted to three levels. 

 

5.10 Slicer 

 

The specified range is divided into eight sections, and these eight sliced sections are assigned 

to the respective performance pads. While one of the performance pads is clicked and long-

pressed, the sound divided for the section and assigned to that pad plays as a loop. 

During loop playback of the pad’s sound, normal playback with the original rhythm continues in 

the background. When the pad is released and loop playback ends, playback resumes from the 

position reached at that point.  

・The slicer function cannot be used with tracks for which no beatgrid is set. For details on 

setting beatgrids, see 5.2.10 Grid edit. 

 

5.10.1 To use the slicer function 

 

 Click the [SLICER] button of the track 

The panel is changed to the slicer mode. 

 Click  button to switch to the slicer loop mode. 
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- For Slicer mode, see 5.10.2 Differences between slicer mode and slicer loop mode  

 To disable the slicer mode and the slicer loop mode, click one of the followings: the 

[HOT CUE] button, the [PAD FX] button or the [BEAT JUMP] button. 

 

 Click the [LENGTH ] button or the [LENGTH ] button 

1 3The slicing range is set to one of four settings: 2 beats, 4 beats, 8 beats and 16 

beats.  

 The slicing area is divided equally in eight, and the eight sliced sections are assigned 

to each performance pad as shown below. 

 

 

 

 Long-press one of the performance pads 

While the pad is long-pressed, the sound of the assigned section plays in a loop.    

・The length of loop playback differs depending on the setting at the [ROLL] 

 

・The value at the [ROLL] depends on the [LENGTH] , and can be set 

at the range from 1/64 to 1/8 of the value of the [LENGTH]. 
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When the pad is released, the track returns to the position that is playing in the 

background. 

2 Click the [SHIFT ] button or the [SHIFT ] button. 

It moves the range of the slicer.  

The change depends on the value of the [LENGTH]  

 

5.10.2 Differences between slicer mode and slicer loop mode 

 Slicer mode 

When the playback position reaches the end of the slicing range that has been divided into eight 

sections, the range shown on the display changes to the next slicing range that is to be divided 

in eight sections. 

These sliced sections are assigned to the respective pads, replacing the previously assigned 

sections. 

 

 

 

 

 Slicer loop mode 

When the playback position reaches the end of the slicing range, the playback position returns 

to the beginning of the same range.   
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5.11 CAPTURE 

You can extract a section of a track and use it a sampler. 

Extract the range of the [LOOP] in the loop play or the range of the [SLICER] in the slicer play.   

 

 

 

See 5.11 Sampler to see how to use a sampler. 

 

5.11.1 LOOP CAPTURE 

1 Set a loop to the range you wish to extract. (See 5.3.6 Setting loop to see how to 

set a loop.） 

The Deck turns in the loop mode. 

 

2. Click  to the right of the enlarged waveform. 

The color of the loop range changes and the range to extract is set.   

 

3. Drag the loop range and drop to the slot of the sampler deck.  

Audio source is extracted and loaded to a sampler slot and ready to be used as a 

sampler.  
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 The extracted audio source is stored at [Collection] and [Sampler] > [Capture].  

 When [Do not load the loaded slot] is selected at [Preferences] > [Controller] > [Sampler], 

you cannot drag and drop the loop range to a slot if something is already loaded in it.   

 

5.11.2 SLICER CAPTURE 

You can extract the whole range of the slicer or one section of the equally divided eight 

sections. 

 Extract the whole slicing range 

1 Click the [SLICER] mode button. (See 5.10 Slicer for how to use the slicer 

function.)  

2 The Deck turns in the slicer mode. 

 

3 Click  to the right of the enlarged waveform. 

The color of the slicing range changes and the range to extract is set. 
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4 Drag the waveform part of the slicing range and drop to the sampler deck of 

eight sampler slots in either right or left section. 

The audio source is extracted, divided in eight, loaded to eight sampler slot respectively, 

and ready to be used as a sampler. 

 

 

 The extracted audio source is stored at [Collection] and [Sampler] > [Capture].  

 When [Do not load the loaded slot] is ticked at [Preferences] > [Controller] > [Sampler], 

you cannot drag and drop the slicing range to the sampler deck if something is already 

loaded in any slots.   

 

 Extract one sliced section 

1. Click the [SLICER]. (See 5.10 Slicer for how to use the 

slicer function.)  

1 The Deck turns in the slicer mode. 

 

2. Click  to the right of the enlarged waveform. 

The color of the slicing range changes and the range to extract is set. 
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2 3. Drag the number part of the sliced section right below the waveform and drop 

it to a sampler slot. 

3 The audio source is extracted and loaded to the sampler slot and ready to be 

used as a sampler. 

 

 The extracted audio source is stored at [Collection] and [Sampler] > [Capture].  

 When [Do not load the loaded slot] is ticked at [Preferences] > [Controller] > [Sampler], 

you cannot drag and drop the sliced section to a slot if it is already loaded. 

 

5.12 Setting preferences 

To change rekordbox settings, select [Preferences] from the [File] menu to open the 

[Preferences] screen. 

Preferences: View 

Language  Sets the language to be used in the display. 

Browse Font Size Sets the size of the characters. 

Line Space Sets line space of track lists. 

Artwork Sets the size of artwork displayed on the track list and 

Tag List. 

Show the 

selected track 

to the center 

If it is enabled, cursor will be shown in the center of the 

track list. (Selected track is highlighted and shown in the 

center of the displayed track list.) 

Layout Tree View Selects whether or not [iTunes], [rekordbox xml] and 

[Explorer] are displayed in Tree View. 

Playlist Palette Selects whether or not the Playlist Palette is displayed. 
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Display Cue 

Markers in 

Preview 

Selects whether or not Memory Cues and Hot Cues are 

displayed in the waveform on the Preview. 

OSC Sampler Selects whether or not OSC sampler toggle button is 

displayed in the sampler deck. 

Enlarged 

Waveform 

Sets the order of the waveforms of 4Decks (1-2-3-4, or 3-

1-2-4) 

Click [Customize] to change the order. 

Tooltips Sets whether or not tooltips are displayed. 

Waveform Waveform 

Drawing Rate 

Sets drawing rate of waveform. The higher the drawing 

rate, the better the quality of waveform. However CPU 

load increases as the rate increases. 

Color Sets color of enlarged and full waveform. 

Full/Preview 

Waveform 

Change the size of waveform between Full/Half. 

Player Sets the number of Hot Cues (Only for EXPORT mode) 

Beat Count 

Display 

Sets the way to count the bars or beats: 1) from the start to the current 

playing position, 2) from the current position to the nearest cue point 

(bars/beats). 

Click on the 

waveform for 

PLAY/CUE 

Choose [On], and you can start playback, pause and set cues by clicking 

the waveform. 

Left-click: Play/Pause 

Right-click: Current Cue setting, Cue Play 

Color Hot Cue Set colors of Hot Cues 

CDJ: Displays Hot Cues in green and Hot Loop umber 

COLD1: Displays in blue and green 

COLD2: Displays in blue gradation 

COLORFUL: displays in multicolor mode 

PAD FX Sets color of PAD FX 

Sampler Selects color setting of sampler as follows: 1) the color is 

set corresponding to the frequency of the sampler sound 

or 2) fixed color (purple). 

When the color is manually set, samplers are shown in 

the set color regardless of the selection here. 
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Preferences: Audio 

Metronome Sets the sound of the metronome while you are monitoring beat grids of 

music files. 

Audio Designates the audio output device.     

Sample Rate Sets the sampling frequency of audio data sent to an audio device. 

The higher the sampling rate, the closer to the original audio you can 

playback the track. However, as the data amount of the audio increases, 

the load on the audio device also increases, resulting in more audio 

skipping (audio interruption). 

Buffer Size Sets the number of samples sent to an audio device for each data 

transmission. 

A large buffer size reduces audio skipping (audio interruption). However, as 

the transmission delay (latency) increases, scratch and other performances 

may delay. 

Mixer Mode Sets mixer mode to Internal or External. 

Internal mixer mode:  

DJ mix mode using the software mixer function. 

Two-way output: Master Out and Headphone Out.  

External mixer mode: 

DJ mix mode using an external hardware mixer/controller. 

Six-way output: track deck 1-4, sampler deck and preview 

Input Channels Designates audio input channel. The input audio you set is the record 

source for recording function. Click [Utility] to start utility settings for audio 

device which enables settings for input to the computer. 

Output 

Channels 

Sets audio output channel. 

When mixer mode is Internal; 

 Sets two-way output channel: Master Out and Headphone Out. 

When mixer mode is External; 

      Sets six-way output: Output Deck 1-4, Output Sampler Deck and 

      Output Preview. 

Preview Sets volume level of preview audio in PERFORMANCE mode. 

Control Device 

Information 

Displays HID/MIDI controller currently connected.  
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Preferences: Analysis 

Track 

Analysis 

Track Analysis  

Mode 

Sets the mode for analysis for music file’s waveform 

information. 

 Normal: Suitable for analysis of tracks which have a 

relatively consistent tempo 

BPM Range: Sets BPM range to display for BPM obtained 

by normal analysis 

 Dynamic: Suitable for analysis of tracks which contain 

significant tempo changes 

Sets Memory 

Cue at the first 

beat when 

analyzing 

Automatically sets Memory Cue at the first beat when 

analyzing 

Key 

Analysis 

Enable Key 

Analysis on 

import 

Sets whether or not to detect the keys when importing music 

files to Collection. 

Write the value 

to the ID3 tag 

Detected key is saved to the ID3 tag. 

Analysis 

Process 

Sets concurrent process mode for track analysis. “Performance” mode allows high 

speed analysis, although CPU load increases. 

 

  



206 

 

 

 

Preferences: Controller 

DECK Eject/Load 

Lock 

Select [LOCK], and music files cannot be loaded to the 

deck while a track is playing. 

Needle Lock Select [LOCK], and needle search will not work while a 

track is playing. 

Memory Cue 

Call Lock 

Select [LOCK], and Memory Cue will not be called out 

while a track is playing. 

Load Load Setting Tick if you wish to start 

playback at Memory/Hot 

Cue nearest to the 

beginning to the track  

Load Method Select Load Button/ Rotary 

Selector (Push) 

Vinyl Speed 

Adjust 

Touch/Brake:  

You can adjust the speed of the pause when touching the 

top of Jog Dial or pushing [Play/Pause] button. 

Release/Start： 

You can adjust the speed needed to get to full playback 

speed from pause mode when releasing the top of Jog 

Dial or pushing [Play/Pause] button. 

JOG Rotation 

Speed 

Sets rotation speed of the virtual deck. 

Switch JOG 

Display 

Change information displayed on the virtual deck. 

Select [Current Cue/Slip] or [Hot Cue Countdown] 

・[Current Cue / Slip] 

Displays current cue point, or slip mode when [SLIP] is on. 

・[Hot cue countdown] 

Displays distance to the next Hot Cue within the 5 rotation of the 

jog.  

 

Mixer Auto Gain Select [Enable], and audio volume of the track loaded to a 

deck is automatically adjusted. 

EQ Select [EQ] or [ISOLATOR]. 
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Channel 

Fader Curve 

Sets Channel fader curve. 

Crossfader 

Curve 

Sets crossfader curve. 

Effect 

 

Release FX Sets the number of units to apply Release FX. 

When mixer is in the external mode, Release FX will not 

work if you set the number of the units as 1.  

Selects [Apply Release FX on CFX] or not. 

CFX (Only for DDJ-RZ) Tick if you wish to apply CFX to 

sampler sound when you turn MIC COLOR control knob 

(CFX knob).  

Sampler 

 

 

(Sampler) 

Load Lock 

Select [LOCK] to disable loading another track to the slot 

when it is playing. 

(Sampler) 

Capture 

[Location of Files] 

Sets the location to store captured audio. 

[Do not overwrite the loaded slot.] 

Tick if you wish. 

[ Location of a Bank to save Slicer Capture] 

Select the number of the bank 

(Sampler) 

Auto Panel 

Mode 

Selects [Enable/Disable] to display/hide rekordbox 

sampler deck when pushing [SAMPLER] button on a 

controller compatible with rekordbox.  

(Sequencer) 

Quantize 

Value 

Sets how precisely quantize is applied when a sequence 

is recorded using the sequencer function.  

Other 

 

Quantize 

Settings 

Sets how precisely quantize is applied at a track deck and 

a sampler deck. (1/16 - 1 beat) 

Recordings Location of files: sets location of recorded files to store. 

Start Trigger: sets trigger to start recording (REC Button 

or Audio Signal). 

 

 

 

Preferences: Keyboard 

Keyboard Assigns keyboard shortcuts to each button. 
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Preferences: Advanced  

Database iTunes iTunes Library 

File 

Specifies the xml file of 

the iTunes library to browse in 

[iTunes]. 

Convert iTunes 

“Grouping” to 

rekordbox “Label” 

Sets whether or not to 

store iTunes group information as 

rekordbox label information when 

importing music files from 

the iTunes library to the rekordbox 

Collection. 

rekordbox xml Export BeatGrid 

information 

Sets whether or not to export the beat 

position information of rekordbox to an 

xml file when the rekordbox library is 

exported. 

Imported Library Specifies the playlist library (the 

location of the xml file) to browse in 

[rekordbox xml]. 

Database 

Management 

Select master database (a drive) for use. The master 

database can be transferred to an external device. By 

transferring master database to an external drive storing 

music files, you can manage tracks on multiple computers. 

Browse 

 

 

My tag Sets whether or not My Tag is added to the Comment column 

in the track list. 

Color You can edit comments when you classify music files with 

eight color codes on DJ equipment. For more instruction on 

using Library Browse function of DJ equipment, see the 

Operating Instructions for each DJ equipment. 

KUVO Tick the checkbox to make the track information public on KUVO 

when importing music files. 

View Tick the checkbox to cache track lists. Untick if the memory of 

your computer is insufficient. When you untick it, the speed to 

display iTunes library will improve when you select the track list at 

Tree View. 
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Others Sending Log 

Information 

Agree or disagree to automatically send information on 

error log, etc. of rekordbox to improve the usability of 

Pioneer DJ products. 

 

 

Preferences: License 

This is to activate an application to add DJ function to rekordbox or purchase the license. 

Up to two computers can be activated with one license. 

You can also deactivate it after activation. 

See 2.5 Using PERFORMANCE mode 
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5.13 Menu list 

 

[rekordbox] Menu (Mac only) 

Preferences Opens [Preference] window. 

Services Opens panes for System Preferences, etc. (Mac OS standard feature) 

Hide rekordbox Hides this application. (Mac OS standard feature) 

Hide Others Hides all windows except for this application. (Mac OS standard feature)  

Show All Displays all windows. (Mac OS standard feature) 

Exit rekordbox Exits this application. 

 

 

 

[File] Menu 

Import > Import Track Imports music files to Collection. 

Import > Import 

Folder 

Specifies a folder and imports music files in the folder to Collection. 

Import > Import 

Playlist 

Imports playlist files (M3U and M3U8) as rekordbox playlists.  

Display All Missing 

Files 

Displays a track list in Collection that cannot be played because the 

music file has been deleted, moved, etc. 

Library > Backup 

Library 

Backs up rekordbox library (database such as Collections, playlists, 

etc.), analysis information and music files. 

The backup data can be saved with the date added to the file name. 

Library > Restore 

Library 

Restores rekordbox library (database such as Collections, playlists, 

etc.), analysis information and music files. 

You can restore the library by transferring the backed up library to 

another computer and restoring it.  

Export Collection in 

xml format 

Exports information for all the Playlists in rekordbox library 

(database such as Collections, Playlists, etc.) and information for the 

music files in these Playlists to a single file in xml format. 

Preferences Changes various settings in rekordbox. 

Exit Exits rekordbox 
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[View] Menu 

Full Screen Displays the rekordbox window at full-screen size. 

2DECK Horizontal Displays 2 decks with horizontal enlarged waveforms. 

2DECK Vertical Displays 2 decks with vertical enlarged waveforms. 

4DECK Horizontal Displays 4 decks with horizontal enlarged waveforms. 

4DECK Vertical Displays 4 decks with vertical enlarged waveforms. 

Browse Minimizes deck display to enlarge browse window. 

Show/Hide Pad and 

Platter 

Selects to show/hide Pad and Platter on the screen 

Show Split Screen Displays another window for browser panel.  

My Tag 

Configuration 

Window 

Displays My Tag configuration window to the right side of the track list. 

Related Track List 

Window 

Displays list of related tracks of a selected music file in an additional 

window to the right side of the track list.  

Information Window Displays information on a selected music file to the right side of the 

track list.  

Sub Browser 

Window 

Opens another window to display tree view and track lists.  

 

 

[Track] menu 

Analyze Track Analyzes a selected track to show full waveform, enlarged waveform, BPM, 

beat positions, and bar positions. 

Analyze Key Detects the key of a selected track. 

Analysis Lock Sets On/Off for re-analysis and detection of the key of a selected track. 

Auto Analysis Sets On/Off for auto analysis for imported tracks. 

Reload Tag Reads the ID3 tag information from a selected track again and reloads it to 

the track information of rekordbox library (database such as Collections, 

Playlists, etc.) 

Add To Playlist Adds a selected track to a playlist. 

Import To 

Collection 

Analyzes and adds a selected track to the Collection. 

Export Track Exports a selected track to a device. 
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Remove from 

Collection 

Removes a selected track from the Collection. 

 The music file in your computer is not deleted. 

Show 

information 

Opens [Information] pane and displays information of a selected track. 

Show in 

Explorer 

Opens a folder in which a selected track is stored in Finder or Explorer. 

Relocate Relocates the file path of a music file. 

 

[Playlist] menu 

Export Playlist Exports selected playlist(s) to a device. 

Import Playlist Imports selected playlist(s) in [iTunes] or [rekordbox xml] to rekordbox.  

Create New 

Playlist 

Adds a new playlist in the same hierarchy of a selected playlist or a folder. 

Create New 

Intelligent 

Playlist 

Adds a new intelligent playlist in the same hierarchy of a selected playlist or 

a folder. 

Create New 

Folder 

Adds a new folder in the same hierarchy of a selected playlist or a folder 

Delete Playlist Deletes a selected playlist or an intelligent playlist. 

Sort Items Sorts playlists in a selected folder in ascending order. 

 [Playlists], [Hot Cue Bank List], [Playlists] and [Hot Cue Bank List] in 

[Devices] can be sorted. 

Renumber 

Track Order 

Renumbers tracks as sorted in a playlist. 

Save Playlist 

Info 

Save information of a selected playlist in text or M3U8 format. 

 

 

KUVO 

About KUVO  Displays website links about KUVO and how to use KUVO 

Edit profile Displays KUVO profile site. 

Tutorial Video Jump to the tutorial video of KUVO. 

Privacy 

Settings 

Displays your account made public in KUVO. 

You can make your track information public or private for all the music files 

in Collection. 
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[Help] Menu 

User’s Manual Displays the website at which the Operating Instructions for this software 

is stored. 

Online support Connects to the online support site for this software. 

rekordbox 

Update Manager 

Connects to this software’s update site. 

Activate Displays windows for purchase of the license key and activation. 

About rekordbox  Displays the version of this software. 
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6 Legal information 

 

6.1 Disclaimer 

Please note that Pioneer DJ cannot accept responsibility for legality, morality or reliability of 

operation with regard to use of this software by customers. Problems in operation of this software 

may arise due to the operating environment of the customer’s computer and of this software, as 

well as due to combinations with other software. 

Please note that Pioneer DJ cannot accept responsibility for loss of information registered by the 

customer using this software. Please make a separate note of information you have registered 

and store it in a safe place. 

 

6.2 Copyright warning 

 The use of rekordbox is restricted with regard to the playing and copying of copy-protected 

music contents. 

- The program may not operate properly if copy-protect encryption data is embedded in 

recorded media. 

- Playback, analysis, and other operations may stop if copy-protect encryption data is 

detected to be embedded in recorded media. 

 The materials you record are for your own listening enjoyment, and cannot be used for other 

purposes without permission from the copyright owner. 

- Music recorded from CDs and other media may be protected by the copyright laws of 

individual countries as well as by international convention. You are solely responsible for 

the lawful use of the recordings you make. 

- When handling music that has been downloaded over the Internet, the person who has 

downloaded the music is fully responsible for using the music in compliance with his/her 

contract with the site from which the music was downloaded. 
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6.3 Software end user license agreement 

This Software End User License Agreement (“Agreement”) is between you (both the individual 

installing the Program and any single legal entity for which the individual is acting) (“You” or 

“Your”) and Pioneer DJ Corporation (“Pioneer DJ”). 

 

TAKING ANY STEP TO SET UP OR INSTALL THE PROGRAM MEANS THAT YOU ACCEPT 

ALL OF THE TERMS OF THIS LICENSE AGREEMENT. PERMISSION TO DOWNLOAD 

AND/OR USE THE PROGRAM IS EXPRESSLY CONDITIONED ON YOUR FOLLOWING 

THESE TERMS. WRITTEN OR ELECTRONIC APPROVAL IS NOT REQUIRED TO MAKE 

THIS AGREEMENT VALID AND ENFORCEABLE. IF YOU DO NOT AGREE TO ALL OF THE 

TERMS OF THIS AGREEMENT, YOU ARE NOT AUTHORIZED TO USE THE PROGRAM AND 

MUST STOP INSTALLING IT OR UNINSTALL IT, AS APPLICABLE. 

 

1. DEFINITIONS  

1.1 “Documentation” means written documentation, specifications and help content made 

generally available by Pioneer DJ to aid in installing and using the Program. 

 

1.2 “Program” means all or any part of Pioneer DJ’s software licensed to You by Pioneer DJ 

under this Agreement. 

 

2. PROGRAM LICENSE  

2.1 Limited License. Subject to this Agreement’s restrictions, Pioneer DJ grants to You a limited, 

non-exclusive, non-transferable, license (without the right to sublicense): 

 (a) To install a single copy of the Program in Your computer or mobile device, to use the 

Program only for Your personal purpose complying with this Agreement and the Documentation 

(“Authorized Use”); 

 (b) To use the Documentation in support of Your Authorized Use; and 

 (c) To make one copy of the Program solely for backup purposes, provided that all titles and 

trademark, copyright and restricted rights notices are reproduced on the copy. 

 

2.2 Restrictions. You will not copy or use the Program or Documentation except as expressly 

permitted by this Agreement. You will not transfer, sublicense, rent, lease or lend the Program, 

or use it for third-party training, commercial time-sharing or service bureau use. You will not 

Yourself or through any third party modify, reverse engineer, disassemble or decompile the 
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Program, except to the extent expressly permitted by applicable law, and then only after You 

have notified Pioneer DJ in writing of Your intended activities. 

 

2.3 Ownership. Pioneer DJ or its licensor retains all right, title and interest in and to all patent, 

copyright, trademark, trade secret and other intellectual property rights in the Program and 

Documentation, and any derivative works thereof. You do not acquire any other rights, express 

or implied, beyond the limited license set forth in this Agreement. 

 

2.4 No Support. Pioneer DJ has no obligation to provide support, maintenance, upgrades, 

modifications or new releases for the Program or Documentation under this Agreement. 

 

3. WARRANTY DISCLAIMER 

 THE PROGRAM AND DOCUMENTATION ARE PROVIDED “AS IS” WITHOUT ANY 

REPRESENTATIONS OR WARRANTIES, AND YOU AGREE TO USE THEM AT YOUR SOLE 

RISK. TO THE FULLEST EXTENT PERMISSIBLE BY LAW, PIONEER DJ EXPRESSLY 

DISCLAIMS ALL WARRANTIES OF ANY KIND WITH RESPECT TO THE PROGRAM AND 

DOCUMENTATION, WHETHER EXPRESS, IMPLIED, STATUTORY, OR ARISING OUT OF 

COURSE OF PERFORMANCE, COURSE OF DEALING OR USAGE OF TRADE, INCLUDING 

ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 

SATISFACTORY QUALITY, ACCURACY, TITLE OR NON-INFRINGEMENT.  

 

4. EXPORT CONTROL AND COMPLIANCE WITH LAWS AND REGULATIONS 

 You may not use or otherwise export or re-export the Program except as authorized by United 

States law and the laws of the jurisdiction in which the Program was obtained. In particular, but 

without limitation, the Program may not be exported or re-exported (a) into any U.S.-embargoed 

countries or (b) to anyone on the U.S. Treasury Department's Specially Designated Nationals 

List or the U.S. Department of Commerce Denied Persons List or Entity List. By using the 

Program, you represent and warrant that you are not located in any such country or on any 

such list. You also agree that you will not use the Program for any purposes prohibited by 

United States law, including, without limitation, the development, design, manufacture, or 

production of nuclear, missile, or chemical or biological weapons.  

 

5. U.S. GOVERNMENT RESTRICTED RIGHTS 

 The Program and Documentations are “commercial computer software” and “commercial 

computer software documentation” as those terms are defined in 48 C.F.R. §252.227-7014 (a) 

(1) (2007) and 252.227-7014 (a) (5) (2007). The U.S. Government’s rights with respect to the 
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Program and Documentations are limited by this license pursuant to 48 C.F.R. § 12.212 

(Computer software) (1995) and 48 C.F.R. §12.211 (Technical data) (1995) and/or 48 C.F.R. 

§227.7202-3, as applicable. As such, the Program and Documentations are being licensed to 

the U.S. Government end users: (a) only as “commercial items” as that term is defined in 48 

C.F.R. §2.101 generally and as incorporated in DFAR 212.102; and (b) with only those limited 

rights as are granted to the public pursuant to this license. Under no circumstance will the U.S. 

Government or its end users be granted any greater rights than we grant to other users, as 

provided for in this license. Manufacturer is Pioneer DJ Corporation, 1-1 Shin-Ogura, Saiwai-ku, 

Kawasaki-shi, Kanagawa-Ken, 212-0031 Japan  

 

6. DAMAGES AND REMEDIES FOR BREACH 

 You agree that any breach of this Agreement’s restrictions would cause Pioneer DJ irreparable 

harm for which money damages alone would be inadequate. In addition to damages and any 

other remedies to which Pioneer DJ may be entitled, You agree that Pioneer DJ may seek 

injunctive relief to prevent the actual, threatened or continued breach of this Agreement. 

 

7. TERMINATION 

 Pioneer DJ may terminate this Agreement at any time upon Your breach of any provision. If 

this Agreement is terminated, You will stop using the Program, permanently delete it from your 

computer or mobile device where it resides, and destroy all copies of the Program and 

Documentation in Your possession, confirming to Pioneer DJ in writing that You have done so. 

Sections 2.2, 2.3, 2.4, 3, 4, 5, 6, 7 and 8 will continue in effect after this Agreement’s 

termination. 

 

8. GENERAL TERMS  

8.1 Limitation of Liability. In no event will Pioneer DJ or its subsidiaries be liable in connection 

with this Agreement or its subject matter, under any theory of liability, for any indirect, incidental, 

special, consequential or punitive damages, or damages for lost profits, revenue, business, 

savings, data, use, or cost of substitute procurement, even if advised of the possibility of such 

damages or if such damages are foreseeable. In no event will Pioneer DJ’s liability for all 

damages exceed the amounts actually paid by You to Pioneer DJ or its subsidiaries for the 

Program. The parties acknowledge that the liability limits and risk allocation in this Agreement 

are reflected in the Program price and are essential elements of the bargain between the 

parties, without which Pioneer DJ would not have provided the Program or entered into this 

Agreement. 
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8.2 The limitations or exclusions of warranties and liability contained in this Agreement do not 

affect or prejudice Your statutory rights as consumer and shall apply to You only to the extent 

such limitations or exclusions are permitted under the laws of the jurisdiction where You are 

located. 

 

8.3 Severability and Waiver. If any provision of this Agreement is held to be illegal, invalid or 

otherwise unenforceable, that provision will be enforced to the extent possible or, if incapable of 

enforcement, deemed to be severed and deleted from this Agreement, and the remainder will 

continue in full force and effect. The waiver by either party of any default or breach of this 

Agreement will not waive any other or subsequent default or breach. 

 

8.4 No Assignment. You may not assign, sell, transfer, delegate or otherwise dispose of this 

Agreement or any rights or obligations under it, whether voluntarily or involuntarily, by operation 

of law or otherwise, without Pioneer DJ’s prior written consent. Any purported assignment, 

transfer or delegation by You will be null and void. Subject to the foregoing, this Agreement will 

be binding upon and will inure to the benefit of the parties and their respective successors and 

assigns. 

 

8.5 Entire Agreement. This Agreement constitutes the entire agreement between the parties and 

supersedes all prior or contemporaneous agreements or representations, whether written or 

oral, concerning its subject matter. This Agreement may not be modified or amended without 

Pioneer DJ’s prior and express written consent, and no other act, document, usage or custom 

will be deemed to amend or modify this Agreement. 

 

8.6 You agree that this Agreement shall be governed and construed by and under the laws of 

Japan. 

  

6.4 Trademarks, licenses, etc. 

 rekordbox is trademarks or registered trademarks of the Pioneer DJ Corporation. 

 Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the 

United States and/or other countries. 

 Apple, Finder, iPhone, iTunes, Macintosh, and Mac OS are trademarks of Apple Inc., registered in the 

U.S. and other countries. 

 App Store is a service mark of Apple Inc. 
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 Android and Google Play are trademarks of Google Inc. 

 Wi-Fi is a registered mark of the Wi-Fi Alliance. 

 The audio compression technology for MP3 is offered under the license of Fraunhofer IIS and 

Thomson Multimedia. 

 This product has been licensed for nonprofit use. This product has not been licensed for commercial 

purposes (for profit-making use), such as broadcasting (terrestrial, satellite, cable or other types of 

broadcasting), streaming on the Internet, Intranet (a corporate network) or other types of networks or 

distributing of electronic information (online digital music distribution service). You need to acquire the 

corresponding licenses for such uses. For details, visit http://www.mp3licensing.com . 

 The names of companies and products mentioned herein are the trademarks of their respective 

owners. 

 

2015 Pioneer DJ Corporation. All rights reserved. 

Pioneer DJ Corporation 

1-1, Shin-ogura, Saiwai-ku, Kawasaki-shi, Kanagawa 212-0031, Japan 
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